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Tektronix supplies and accessories

To order supplies and accessories, contact your local dealer or visit the
Tektronix web site:

. . %)
www.tek.com/Color_Printers/products/supplies.html <
-
. e
ColorStix Ink «
Item Part Number
3 Free Black sticks 016-1831-00
5 Cyan sticks plus 2 Free Black sticks 016-1825-00
5 Magenta sticks plus 2 Free Black sticks 016-1826-00
5 Yellow sticks plus 2 Free Black sticks 016-1827-00
2 Cyan sticks plus 1 Free Black stick 016-1828-00
2 Magenta sticks plus 1 Free Black stick 016-1829-00
2 Yellow sticks plus 1 Free Black stick 016-1830-00
Tektronix Paper
Item Size Description Part Number
Premium Color Al/Letter (U. S.) 500 sheets 016-1368-00
Printing Paper 8.5 x 11 in. 24-1b. bond, 90 g/m?
Premium Color A4 (Metric) 500 sheets 016-1369-00
Printing Paper 210 x 297 mm 24-lb. bond, 90 g/rn2
High Resolution  A/Letter (U. S.) 25 sheets 016-1808-00
Photo Paper 8.5 x 11 in. 170 g/m?
High Resolution A4 (Metric) 25 sheets 016-1809-00
Photo Paper 210 x 297 mm 170 g/rn2
Premium Cover  A/Letter (U. S.) 100 sheets 016-1823-00
8.5 x 11 in. 60-1b. cover, 160 g/m?
Premium Cover A4 (Metric) 100 sheets 016-1824-00
210 x 297 mm 60-1b. cover, 160 g/m?
User Guide 9
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Supplies

Transparencies

Item Size Description Part Number

Premium A/Letter (U. S.) 50 sheets 016-1724-00
8.5 x 11 in.

Premium A4 (Metric Letter) 50 sheets 016-1725-00
210 x 297 mm

Standard A/Letter (U. S.) 50 sheets 016-1720-00
8.5 x 11 in.

Standard A4 (Metric Letter) 50 sheets 016-1721-00

210 x 297 mm

Color Printing Labels

Size Description Part Number
A/Letter (U. S.) 100 sheets / 30 labels per sheet 016-1812-00
8.5 x 11 in. (each 1 x 2-5/8 in.)
Al/Letter (U. S.) 100 sheets / 6 labels per sheet 016-1813-00
8.5x 11 in. (each 3-1/3 x 4 in.)
A4 (Metric Letter) 100 sheets / 14 labels per sheet 016-1814-00
210 x 297 mm (each 38.1 x 99.1 mm)
A4 (Metric Letter) 100 sheets / 8 labels per sheet 016-1815-00
210 x 297 mm (each 67.1 x 99.1 mm)
Maintenance Kit
Item Part Number
Extended replacement maintenance roller and counter 016-1834-00
(Life: up to 45,000 images or two years, which ever comes
first.)
Standard replacement maintenance roller and counter 016-1822-00

(Life: up to 10,000 images or two years, which ever comes
first.)
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Replacement items

Item Part Number

Maintenance Waste Tray (replacement) 436-0370-01

Maintenance Drawer (replacement) 436-0383-00

Rapid Release Guide 650-4153-00
Additional memory

Features Part Numbers

m Improved performance m 64 Mbytes: ZMB64

m Up to 256 Mbytes maximum m 128 Mbytes: ZMB128

The printer has two memory slots. When adding memory, you can use

64-Mbyte and 128-Mbyte DIMMs in combination.

Trays
Size Description Part Number
Standard Paper/Transparency Tray = A/Letter (U. S.) 436-0330-00
Standard Paper/Transparency Tray = A4 (Metric Letter) 436-0332-00
High-Capacity Transparency/ A/Letter (U. S.) 436-0336-00
Label Tray
High-Capacity Transparency/Label A4 (Metric Letter) 436-0338-00

Tray

Cleaning Kit

Item

Part Number

Package of 5 alcohol wipes

016-1845-00

User Guide
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High-Capacity Paper Tray Assembly

Features Part Numbers

m Increased paper-printing capacity m U.S.: Z840LTA

m Increased printing versatility and m Metric: Z840LTA Option 01
convenience

m Up to two High-Capacity Paper Tray
Assemblies can be used

Printer Station

Features Part Number

m Ergonomic surface height ZCARTA

m Provides storage for supplies

Internal IDE Hard Drive

Features Part Number

m Required for collation Z850HD
m Extends font capacity

DP Feature Set

Features Part Number

m High Resolution/Photo print-quality =~ Z850FP
mode, 1200 x 600 dpi

m Automatic two-sided printing
capability

m Adds 32 Mbytes of memory (64 Mbytes
total)

m 1st Page Preview functionality

m Quick Collate functionality (requires a
hard drive)

m Page Pipelining

12 Phaser 850 Color Printer



PhaserShare® Network Card

Features

Part Number

m Easy to install
m Increases shareability

m High-performance network connectivity

Token Ring: ZNBTR

User Guide
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The front panel

14

Provides access to printer settings (tray, print-quality mode,
network settings, etc.).

Displays the printer’s operating status (Ready to Print, Printing).

Alerts you to replace consumables, load paper, and clear jams.

3 4
/ 5

/

() Phaser 850 DX /
. READY TO PRINT

x About my Printer

Help ? ®
/,g Printer Demo Help Select

- 5@
77

6

0643-79A.ai
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Key
1. Error indicator

Power indicator

Printer model and current status

B oWN

Display
B Menu: Accesses printer setup menus

m  About My Printer: Displays current printer settings and
information

m  Help: Accesses information and tools for solving printer
problems

m  Printer Demo: Prints sample images and color charts

5. Navigation arrows. Use the arrows to scroll the front panel menus.
6. Select button. Selects highlighted settings.

7. Help button. Press at any time for additional information on
displayed menu options or status messages.

Printing a Menu Map

The Menu Map shows you where features such as the help pages, are
located in the front panel’s menu structure.

1. Scroll to Menu, press Select.

2. Scroll to Print Menu Map, press Select.

User Guide 15
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Features

Print quality modes

Print quality modes selectable from a Maximum speed *
printer driver or the front panel

Fast Color 14 ppm Paper

m Fastest full-color output. 6.5 ppm Transparency

m Useful for many images and previewing
work.

m Produces good peer-level documents.

m Useful for rush jobs when saturated
colors are not necessary.

Standard 8 ppm Paper

m General-purpose mode for 3.5 ppm Transparency
full-color printing.

m Best quality mode for printing
transparencies.

m Suitable for most office uses.

m Produces vibrant, saturated prints with
smooth color transitions.

Enhanced * * 4 ppm Paper

m Superior text resolution and
very smooth light colors.

m Balance of high quality and fast speed.
m Smoothest and brightest large-area fills.

m Useful for printing paper copies of
overhead presentations.

High Resolution/Photo * * 2 ppm Paper
m Highest-quality color prints.

m Near-photographic detail.

= 1200 x 600 dpi.

m Requires DP or DX Feature Set.

* Approximate number of pages per minute; does not include image
processing time. Based on prints with margins of .5 in. or greater.
**Transparencies are printed in Standard mode.
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TekColor" color corrections

Color corrections
selectable from a

printer driver or the

Description

front panel

Automatic Automatically applies the best color correction
mode to each element on the page

None No color correction made to colors
Used with the PANTONE® Color Chart for
PANTONE?® Color matching

Vivid Color Produces the brightest possible colors and makes

blues appear less purple

sRGB Display

Closely approximates the colors on a standard
display screen

SWOP Press

Specification for Web Offset Publications. Used
to match U. S. press standards

Euroscale Press

Used to match equivalent Imation Matchprint®
proofs

Commercial Press

Used to match commercial Imation Matchprint®
proofs

SNAP Press Specifications for Non-Heat Advertising Printing
Used to match standards for printing on uncoated
and newsprint papers

DIC Used to match Dai Nippon printing inks on
coated paper

Toyo Used to match commercial Toyo printing inks on
coated paper

FujiProof Used to match the Fuji Color Art System for
commercial North American proofs

Black and White Grayscale printing

Used to print page masters for photocopying in
black-and-white

User Guide

17



Paper tips

18

Print the Paper Tips Page from the printer’s front panel for a
detailed list of paper types and sizes.

When you select a tray by location (Upper, Middle, Lower) from a
printer driver, the printer feeds from that tray.

Always keep stored paper, transparencies, and labels, in sealed
packages to avoid the effects of moisture which can affect feed
reliability.

Always use the manual-feed slot for heavy paper and envelopes.

Handle transparencies by the edges and with both hands to avoid
fingerprints and creases, which can result in poor print quality.

Do not use three-hole punched paper, perforated paper, or an
unsupported paper size.

Phaser 850 Color Printer



Supported page sizes and print area

The image area of a print is a bit smaller than the paper size. You may
need to adjust the page margins in your application software to match
the print area.

To print from a supported driver, select Print. Select Page Size.
Choose one of the following sizes.

Paper* Page size Print area Top/ Left/
Bottom Right
margins margins

1. Letter 8.5 x 11 in. 8.112x 10.612 in. .2 in. .2 in.
2. Executive 7.25x 10.5in. 6.85x9.95 in. .2751in. .2 1in.
3. A4 210x 297 mm 200 x 287 mm 5 mm 5 mm
4. A5 148 x 210 mm 138 x 196 mm 7 mm 5 mm

*Transparencies available in Letter- and A4-sizes only.

0643-65.ai
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Paper Tips

Caution

Never use envelopes with windows or metal clasps; they will
damage the printer. Use only the recommended envelope
sizes. Envelopes must always be placed with the flap

face-up.

For better results, use light-weight, laser-quality envelopes.

Envelopes Page size Print area Top/ Left/
Bottom Right
margins margins
(A/B) (C/D)

#10 (U. S.) 4,13 x 9.5 in. 3.73 x 8.95 in. .2 in. .275 in.

#6%, (U.S.) 3.65 x 6.5 in. 3.25 x 5.95 in. .2 in. .275 in.

Monarch (U. 3.875 x 7.5 in. 3.475x6.951in. .2in. .275 in.

S.)

C5 162 x 229 mm 152 x 197 mm 5 mm 7 mm

25 mm

DL 110 x 220 mm 100 x 206 mm 5 mm 7 mm

Choukei 3 Gou 120 x 235 mm 110 x 221 mm 5 mm 7 mm

Choukei 4 Gou 90 x 205 mm 80 x 191 mm 5 mm 7 mm

A A
C D C I D
B B

20
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Manual-feed printing

Supported media

See page 9 for supplies ordering information.

Paper

B Sizes:

m  A/Letter
m  Executive
m A4

m A5

m  Bond or equivalent, 60 - 150 g/mz; 16 - 40 1b.

m  Heavy papers 150 - 216 g/m?: for example, cover stock
216 g/m2 or 80-lb., and index stock 110-lb.; single-sided
printing only

B Coated or Glossy papers, single-sided printing only

m  Short-grained paper, at least 105 g/m? and up to 150 g/m?;
28 - 40 1b. bond

B Tektronix Premium Cover, single-sided printing only

B Tektronix High Resolution Photo, single-sided printing only

Transparencies

B Sizes: A/Letter and A4

m  Use only Phaser 850 printer transparencies

Labels

B Sizes: A/Letter and A4

®  Use only Phaser 850 printer Color Printing Labels

User Guide
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Manual-Feed

Envelopes

For better results, use light-weight, laser-quality envelopes.

#10 (U. S.)

#6 3/4 (U.S.)
Monarch (U. S.)
C5

DL

Choukei 3 Gou
Choukei 4 Gou

Using the manual-feed slot for single-sided printing

To use the manual-feed slot for single-sided printing, follow these
steps. To use the manual-feed slot for two-sided printing, see
Automatic two-sided printing on page 40.

Note

22

Refer to page 42 for instructions on loading letterhead for
two-sided printing.

In a supported printer driver, select Manual Feed Paper or
Manual Feed Transparency.

m  Make sure that two-sided printing is turned off in the
printer driver.

To send the job to the printer, click Print.
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3. Open the manual-feed slot.

4. Align the paper, transparency, or envelope, with the left side of
the slot. For either Letter- or A4-size, adjust the guides on the
right side of the slot.

5. When the front panel reads Waiting for Manual Feed, insert one
sheet or envelope until the printer pulls it in:

m  Top of the page enters first.
m  Side to be printed is face-down.

m To avoid jams, make sure the sheet or envelope is properly
aligned as it enters the printer

m  Check the first print to make sure the image placement is
correct.

6. Wait for the front panel’s prompt before inserting
additional sheets.

0643-67
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Manual-feed speciality media overview

1. Letterhead or High-Resolution Photo
See Loading letterhead paper for two-sided printing on page 42
and Printing on High Resolution Photo Paper on page 37 for more
information.

2. Transparencies

Labels
See Printing on labels on page 38 for more information.

1 2 3

L | L |
S

0643-68
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1. Envelopes
See Printing on envelopes on page 26 for more information.

2. Executive/A5 small papers

1 2

L Jr— I_—J

{—_ o] puis

0643-149

Caution

Never use envelopes with windows or metal clasps; they will
damage the printer. Only use the recommended envelope

sizes. Envelopes must always be placed with the flap
face-up.
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Printing on envelopes
1. In your application, create a document matching the
measurements of the envelope (see page 19 for dimensions).

2. From your application, make these selections and send the job to
the printer:

Set the orientation to Landscape.
Select your envelope size.

Select Manual Feed Paper as the Paper Source.

If your application has a tool for creating envelopes, select
the feed method that matches the illustration in Step 4.

3. Wait for the front panel prompt before loading an envelope.
4. Insert one envelope into the manual-feed slot:

Short end enters first.
Side with the flap is face-up.
Flap is closed.

For side-flap envelopes: Flap end is on the left.
For end-flap envelopes: Flap end enters first.

L | |
| |

0643-97
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Guidelines for envelope printing

Use the recommended envelope sizes (see page 19)

For better results, use light-weight, laser-quality envelopes.
No windows or metal clasps

No exposed gummed surfaces

Single-sided printing only

Keep unused envelopes in their original packaging to avoid dust

Many applications include a tool for creating an envelope. Refer
to your application’s documentation.

Printing envelopes from a Macintosh

To print envelopes from Microsoft WORD on a Macintosh, follow
these steps:

1. From the Tools menu, select Envelopes and Labels.

2. In the Envelopes and Labels dialog box, click the Envelopes tab.
3. In the Envelopes tab, type in delivery and return addresses.

4, C(Click the Feed icon.

5. In the Printing Options tab, select all of the following:

Face Down
Clockwise Rotation

Use Envelope Feeder

Left envelope feed icon:

A

0643-148.ai
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Envelopes

© ® N o

11.

12.
13.

14.
15.

28

Click the Envelope Options tab.
In the Envelope size drop-down list, select your envelope size.
Click OK.

In the Envelopes and Labels dialog box, click Print to open the
Page Setup dialog box.

. In the Page Setup dialog box, select all of the following

Page Attributes:
m  Paper: select your envelope size.
m  Orientation: select Landscape.

From the drop-down list, select PostScript Options, and make the
following selections:

m  Flip Horizontal
m  Flip Vertical
Click OK; the Print dialog box opens.

In the Print dialog box, in General options, for Paper Source
select Manual Feed Paper.

Click Print.

The printer’s front panel prompts you to insert the envelope.

Phaser 850 Color Printer



From other Macintosh applications: If the envelope address prints
upside-down, change the Page Setup settings in your printer driver
before printing:

1.
2.

N o v &

From the File menu, select Page Setup.
Select the following Page Attributes:

m  Paper: select your envelope size.
m  Orientation: select Landscape.

From the drop-down list, select PostScript Options, and make the
following selections:

m  Flip Horizontal
m  Flip Vertical
Click OK.

From the File menu, select Print.
For Paper Source, select Manual Feed Paper.

To print, click Print.

User Guide 29



Printing envelopes from Windows

To print envelopes from Microsoft WORD for Windows, follow
these steps:

1. From the Tools menu, select Envelopes and Labels.
2. In the Envelopes and Labels dialog box, click the Envelopes tab.
3. In the Envelopes tab, type in delivery and return addresses.

4. Click the Feed icon.

5. In the Printing Options tab, select all of the following:

Face Down
Clockwise Rotation

For Feed From, select Manual Feed Paper.

Left envelope feed icon:

A

0643-148.ai

Click the Envelope Options tab.
In the Envelope size drop-down list, select your envelope size.
Click OK.

© ® N o

In the Envelopes and Labels dialog box, click Print.

10. The printer’s front panel prompts you to insert the envelope.
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Loading the Standard Paper/
Transparency Tray

Supported media

See page 9 for supplies ordering information.

Paper

200-sheet capacity
Bond or equivalent, 60 - 150 g/mz, 16 - 40 1b.

m  Heavy papers 150 - 176 g/m?, 40 - 65-1b.; for example, cover stock
176 g/m? or 65-1b.; single-sided printing only

m  Coated or glossy papers, single-sided printing only

m  Short-grained paper, 105 - 150 g/m?, 28 - 40 lb. bond

m  Tektronix Premium Cover, single-sided printing only

m  Tektronix High Resolution Photo, single-sided printing only

m  Set tray switch to Paper.

Transparencies

B 50-sheet capacity

m  Use only Phaser 850 printer transparencies

B Set tray switch to Transparency.

Labels

B 50-sheet capacity

m  Use only Phaser 850 printer Color Printing Labels

B Set tray switch to Paper.

User Guide
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Trays

Loading the tray

1.

32

Use the tray’s maximum-capacity label to determine how much
paper or transparency to load.

Load paper with the side to be printed face-up.

m  For single-sided printing, load letterhead paper with the top
of the page at the front of the tray.

m  For two-sided printing on letterhead, refer to page 42.

Place the paper snugly against the inside left front wall of the tray.

Set the switch on the side of the tray for Paper or Transparency to
match the loaded media. If you are loading labels in the
Paper/Transparency tray, set the tray switch to Paper.

Insert the tray into the printer.

vVVvyyvyy
Paper

vvyvyy
Transparency

0643-66.ai
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Loading the High-Capacity Paper Tray
Assembly

Supported media
See page 9 for supplies ordering information.

Paper only

B 500-sheet capacity
®  Bond or equivalent, 63 - 120 g/mz, 17 - 32 1b.

B You can use up to two High-Capacity Paper Tray Assemblies with
your printer.

Loading the tray

1. Angle the paper stack to match the angle of the tray.

2. Use the tray’s maximum-capacity label to determine how much
paper to load.

3. Load paper with the side to be printed face-up.

m For single-sided printing, load letterhead paper with the top
of the page at the front of the tray.

m  For two-sided printing on letterhead, refer to page 42.

4. Place the paper snugly against the inside left back wall of the tray.
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5.

34

Insert the tray into the printer.

0389-19
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Loading the optional High-Capacity

Transparency/Label Tray

Supported media
See page 9 for supplies ordering information.

Transparencies

m  175-sheet capacity
m  Use only Phaser 850 printer transparencies

m  Set tray switch to Transparency.

Labels

B 100-sheet capacity
m  Use only Phaser 850 printer Color Printing Labels
B  Set tray switch to Label.

User Guide
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Loading the tray

1. Use the tray’s maximum-capacity label to determine how much
media to load.

2. Load media with the side to be printed face-up.

Place the media snugly against the inside left back wall of
the tray.

4. Set the switch on the side of the tray for Transparency or Label to
match the loaded media.

5. Insert the tray into the printer.

0643-62

6. In the printer driver, make these selections:

m  Select the appropriate tray.

m  Turn off the two-sided printing option.
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Printing on High Resolution Photo Paper

The Tektronix High Resolution Photo Paper is printable on one side
only, and has a Tektronix logo on the reverse.

See page 9 for supplies ordering information.

1. Insert the paper into the appropriate tray:
Standard Paper/Transparency tray: 50 sheets
m  Load paper face-up
m  Set tray switch to Paper.
Manual-feed slot: 1 sheet
m Load paper face-down

2. In the printer driver, make these selections:

m  Select the appropriate tray.
m  Turn off the two-sided printing option.

m  Select High-Resolution Photo as the TekColor color
correction.

3. Send the job to the printer.

User Guide
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Printing on labels

1. Insert the label sheets into the appropriate tray:
Standard Paper/Transparency tray: 50 sheets
m Face-up

m  Set tray switch to Paper.

Labels

Letter-size

Transparency | O

glooinoioon ool

0643-159

High-Capacity Transparency/Label tray: 100 sheets
m  Face-up

m  Set tray switch to Label.

Letter-size

Transparency| O

glionnnonong ool

0643-99.ai

Manual-feed slot: 1 sheet

m Face-down
L]
]

0643-96.ai
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2. If your application has a setting for labels, use it as a template.
Otherwise, for margin settings, refer to the instructions included
with the labels.

3. In the printer driver, make these selections:

m  Select the appropriate tray.
m  Turn off the two-sided printing option.
4, Send the job to the printer.

See page 9 for supplies ordering information.

Guidelines for printing on labels

m  Use only Phaser 850 printer Color Printing Labels.

m  Ifany of the labels on a sheet are missing, do not use that sheet; it
may damage printer components.

Caution

Keep labels in a cool, dry place. Never store labels in a
high-humidity environment. Labels stored under such
conditions will jam in the printer. Store unused labels flat in
their containers. Rotate stock frequently. Long periods of
storage can cause the labels to curl and will jam the printer.
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2-sided Prints

Automatic two-sided printing

Automatically make two-sided prints using the paper trays or the
manual-feed slot. In the Print dialog box, select the two-sided printing
option and a binding preference (how the page turns).

To automatically make two-sided prints:

B Do not place paper that was printed on one side back into the
printer to print on the second side. Pre-printed pages may stick
together.

m  Make sure the Paper/Transparency switch on the tray is set
to Paper.

B Use only Letter- or A4-size paper.

B When the printer operates in automatic two-sided printing mode,
the paper partially exits before printing the second side. To avoid
paper jams, do not touch the paper before it completely exits the
printer.

Caution

Two-sided printing is supported only for Letter- and A4-size
papers within the 16 - 32 1b. range. Make sure two-sided
printing is off in the printer driver for all other paper types.

Macintosh Drivers

LaserWriter 8.6 From the File menu, select Print.
From the pull-down menu, select Layout.
Select Print on Both Sides.

Select a binding preference.

LaserWriter 8.3.4 From the File menu, select Print.
Click the Options button.
Select 2-Sided Printing.

Select Short-Edge Binding or Long-Edge Binding.
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PC Drivers

Windows 95 m From the File menu, select Print.
Windows 98 m Click Properties.

m Click the Setup tab.

m Select Print on 2 sides.

m Check or uncheck Bind on top edge.
Windows NT4 m Start/Settings/Printers.

Right-mouse-button-click on your printer’s icon.

From the pop-up menu, select Document
Defaults.

Click the Advanced tab.
Under Paper/Output, select Print on Both Sides.
Select Long Side or Short Side.

Binding preference

=t

# 4
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Two-sided Prints

Loading letterhead paper for two-sided printing

To load letterhead paper for two-sided printing, follow these
additional steps.

Caution

Do not place paper that was printed on one side back into the
printer to print on the second side. Pre-printed pages may
stick together.

1. Load the paper in the paper tray or the manual-feed slot:

m  Paper tray
Letterhead side is face-down.
Place the top of the page at the back of the tray.

E|]|] opooooonoog HDS
0643-98

m  Manual-feed slot
Letterhead side is face-up.
Top of the page enters the printer last.
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2. In your printer driver, in the Print dialog box, select the tray by

location:

m  Upper

= Middle

m  Lower

m  Manual Feed Paper
Note

When the printer operates in automatic two-sided printing
mode, the paper partially exits before printing the second
side. To avoid paper jams, do not touch the paper before it
completely exits the printer.
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Adding ink
Caution

Use only Phaser 850 printer ColorStix® ink; the use of other
ink may affect print quality and reliability. Tektronix
warranties and service contracts do not cover damage,
malfunction or degradation of performance caused by the use
of non-Tektronix supplies or consumables or the use of
Tektronix supplies not specified for use with this printer.

See page 9 for supplies ordering information.

Ink tips:

B Keep ink in its packaging until you are ready to use it.

B To avoid ink jams, never insert broken ink sticks into the
ink-loading bins.

Loading ink:

To load ink any time the printer is Idle, or when the front panel

displays Ink low or Ink out, follow this procedure.

1. Open the top cover. A color-coded label inside the top cover
corresponds to the color of each ink-loading bin.

2. Remove the ink stick from its packaging.
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4.

Place the appropriate color ink stick into the ink-loading bin that
appears low. Do not force the ink sticks into the ink-loading bins.

Each ink stick is uniquely shaped to fit into the correct
ink-loading bin. Insert the ink stick’s narrow end first.

0643-141.ai

Close the top cover.

The front panel may read Processing until the printer is ready for
printing.
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Waste Tray

Emptying the waste tray

When the front panel displays Empty Waste Tray, follow this
procedure.

See page 9 for supplies ordering information.

Caution

The printer’s interior may be hot. Do not reach into the
printer while the maintenance drawer is removed.

1. Open the front cover.

2. Grasp the maintenance drawer, labeled as A, and pull it out of the
printer.

Note

The maintenance drawer may be locked while the ink
cools after the front panel troubleshooting routine,
Eliminate Light Stripes. Make sure all covers are
closed. Wait 15 minutes before trying to remove the
maintenance drawer. The maintenance drawer may
also be locked during the warm up cycle whenever the
printer is turned on.
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3. The waste tray may be hot; handle it carefully.
Lift the waste tray, labeled as B, from the maintenance drawer.

0643-157

4. Empty the waste tray by gently twisting the tray or tapping it on
the sides of a waste container. Ink is non-toxic and can be
discarded as normal office waste.

5. Replace the waste tray in the maintenance drawer. Make sure the
waste tray is seated flat in the maintenance drawer.

6. Reinsert the maintenance drawer into the printer and close the
front cover.

4
Y X
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Replacing the Maintenance Kit

The Maintenance Kit is a consumable that consists of the maintenance
roller and counter. The kit is located in the Maintenance Drawer,
labeled as A, behind the printer’s front cover.

Detailed, illustrated instructions are included with each new
Maintenance Kit. See page 9 for supplies ordering information.

The front panel displays these messages:

Front panel message Action

Maintenance Kit is low Order a replacement maintenance
kit; replace the Maintenance Kit
soon.

Replace Maintenance Kit Replace the Maintenance Kit to

continue printing.

Make sure the new counter is
installed.

Maintenance Kit Missing Reinstall the counter or
maintenance drawer.

Preventative Maintenance: Replace  Press the Help button on the front
Maintenance Kit panel for details.

B The Standard Maintenance Kit has a life of 10,000 prints or
2 years, whichever comes first.

B The Extended Maintenance Kit has a life of up to 45,000 prints
(depending on ink coverage) or 2 years, whichever comes first.
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Caution

The printer may be hot. Do not reach into the printer
while the maintenance drawer is removed.

0643-125.ai
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Jams

Removing paper jams

The front panel message indicates the jam location and information on
how to clear the jam. Check the front panel for Troubleshooting Jams
information.

To prevent jams, use only the recommended papers, transparencies,
and labels (see page 18), and clean the printer’s rollers if visibly dirty.
For complete cleaning instructions, refer to the printer’s CD-ROM or
on the Tektronix web site.

Media Jam — Open Exit Cover to Clear

Solution 1

If the paper has partially exited the printer at the exit slot, follow these
steps. Otherwise, refer to Solution 2 on page 51.
1. Open the exit cover.

2. Using both hands, remove the jammed paper.

Remove the entire sheet of paper; any pieces of paper left in the
printer may cause more jams.
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Solution 2

If paper gets caught under the Rapid Release Guide, follow these steps.

Caution
Handle the Rapid Release Guide carefully to avoid bending
or damaging the clear plastic edge.

1. Open the exit cover.

2. Lift the blue paper guide.

/////_ 0643-150

Lift up on the blue tabs and remove the Rapid Release Guide. Do

3.
not use any sharp objects in this area of the printer.

7

0643-151
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Jams

4.

5.

52

Remove the jammed paper.

7 0643-152

Make sure the thin, white dust shield is lying on top of the metal
shaft. Then, reinstall the Rapid Release Guide, pressing down on
the blue tabs to snap the guide into place.
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Media Jam — Open front cover to clear

0643-72.ai

1. Open the front cover.
2. Using both hands, remove the jammed paper.

3. If there is any resistance to removing the jammed paper, turn the
blue thumbwheel to help feed the paper.

4. Remove the entire sheet of paper; any pieces of paper left in the
printer may cause more jams.
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Media Jam — Retry manual feed

0643-158

1. Using both hands, remove the jammed paper, transparency, or
label sheet.

2. When prompted by the display message, reinsert the sheet using
both hands.

Make sure you insert the sheet properly, so it enters the printer
straight and evenly. Be especially careful to properly line up
envelopes and small-size papers.

-1

0643-143.ai
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Media Jam — Remove media (or upper) tray to clear

1. Remove the paper tray (if your printer has more than one tray,
pull out the upper tray).

2. Using both hands, remove the jammed paper.
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Media Jam — Remove middle tray to clear

Media Jam — Remove lower tray to clear

0643-75.ai

1. Remove the paper tray named in the front panel display.

2. Using both hands, carefully remove the jammed paper.
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Troubleshooting print quality

Light stripes or missing colors

Clean the printhead with the printer’s front panel troubleshooting

T‘A

0643-56.ai

1. On the front panel, scroll to Menu. Press Select.

2. Scroll to Troubleshooting; press Select.

Scroll to Print Diagnostic Test Page; press Select. These
illustrations show a correct Test Page and an example of a
Test Page with a missing color bar.

A. Correct test page B. Missing color bar

0643-135.ai
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Print Quality

58

If the test print looks like example B in the illustration, go on to
Step 5.

Scroll to Eliminate Light Stripes; press Select.

Check the test print that prints automatically, to confirm that the
problem is corrected.

Repeat Step 5 as necessary. If light stripes persist after three
consecutive clean cycles, turn off the printer for 4 hours to allow
the ink to cool and solidify. Then turn on the printer and repeat
the clean cycles, if necessary.

For more details, refer to the troubleshooting information on the
printer’s CD-ROM or on the Tektronix web site.
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Oil or ink smears

Oil (drum fluid) on a print or ink smears on the front, back or
edges of a page.

e

0643-59.ai

Clean the printer’s internal paper path using the front panel
troubleshooting routine.

1.

i & uw N

Load the upper tray with sheets of clean, high-grade paper,
preferably 120 g/m?; 32-1b. This cleaning routine uses several
sheets of paper.

On the front panel, scroll to Menu. Press Select.
Scroll to Troubleshooting; press Select.
Scroll to Remove Ink Smears; press Select.

If the problem persists, additional cleaning may be necessary. For
complete cleaning instructions, refer to the printer’s CD-ROM or
on the Tektronix web site.
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Ink streaks

Ink streaks or marks on the top edge, front or back of a page.

3

0643-60.ai

Clean the printer’s paper-exit path:
B To clean the exit rollers, use a pre-soaked alcohol cloth.

B To turn the rollers, use the blue thumbwheel.

0643-94.ai
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Clean the Rapid Release Guide:

1. Follow the steps in Solution 2 on page 51 to remove the Rapid
Release Guide.

2. Gently wipe the clear plastic Rapid Release Guide with a
pre-soaked alcohol cloth.

0643-154

3. Reinstall the Rapid Release Guide, pressing down on the blue tabs
to snap the guide into place.
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Ink smears

Ink smears on the bottom edge of a page.

S Y

0643-57.ai

Clean the paper-feed rollers.

1. From the front panel, run the Remove Ink Smears routine; see
page 59 for instructions.

2. If smears remain, open the front cover and remove the
maintenance drawer.

3. Toclean rollers in rows 1, 2, and 3, use a pre-soaked alcohol
cloth.

4. To turn the rollers in rows 1 and 3, use the blue thumbwheel.

0643-100.ai

5. Clean any ink from the polished metal guide located between
rollers 1 and 2, using a presoaked alcohol wipe.
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Moving the printer

All moves

Follow these guidelines when moving the printer within the office and
preparing it for shipment:

1. The printer must be cool before moving it; otherwise, ink spills
may damage the printer. Use this method:

a. Close all of the printer’s covers and doors.

b. Turn off the printer. Before the front panel goes blank (you
have only 4 seconds), select Shut Down For Moving Printer.

c. The printer takes about 15 minutes to cool; during that time,
the front panel reports its progress. When the cool-down is
complete, the front panel goes blank. It is now safe to move
the printer.

2. Removing the upper paper tray provides a place for your hands
when lifting the printer.

3. Always move the printer separately from its High-Capacity Paper
Tray Assembly.

A\

L J
36 kg

t 79 Ib.
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Preparing the printer for shipment

Caution

Parts of the printer may be hot; to avoid personal injury,
allow the printer to cool and use caution when handling it.

m  Always repack the printer properly to ensure its safe shipment;
refer to the instructions on the printer’s CD-ROM or on the
Tektronix web site.

B Always remove the maintenance drawer (A) before shipment to
avoid damage to the printer. Place the drawer in a plastic bag for
storage. Never ship the printer with the maintenance drawer
installed.

Moving

0643-125.ai
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Getting help

The printer's auto-running CD-ROM guides you to the various
resources available for installing and learning more about your
Tektronix color printer. Use the CD-ROM to install your printer driver
software, view and print user documentation, and watch "how to"
videos. Live Internet links on the CD-ROM let you access the
Tektronix Color Connection web site, your single source for color
education, interactive tutorials, free templates and support
information.

Printer CD-ROM

Advanced Features and Troubleshooting Manual
Consumables instructions

Setup Guide poster

Video help

Networking manuals

Cleaning instructions

Repacking instructions

Printer drivers

Material Safety Data Sheets (MSDS)

Windows driver help system

Install the driver from the printer’s CD-ROM and use the embedded
help system.

m  Troubleshooting information

B Access to installed manuals and videos

m Live links to the Tektronix web site

User Guide 65

djaH 8uman



Getting Help

Color Connection

colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of
your color printer:

Customized support and automatic driver update notification.
Color education with interactive tutorials and helpful hints.
Free templates and promotions.

Online supplies ordering

Online documentation.

Printer’s front panel

Help menu: Accesses information and tools for solving printer
problems.

Help button: Press at any time for additional information on
displayed menu options or status messages.

Troubleshoot Jams menu: Appears when paper jams, provides
additional information.

Internal printer pages

The printer has several help pages available; refer to the Menu Map for
their locations.

66

Connection Setup: connecting to a computer or network

Diagnostic Test Page: how to solve print problems, such as
smudges or light stripes

Help Guide: Provides specific help resources.
Paper Tips Page: what papers, transparencies, or labels to use

Supplies Page: part numbers and descriptions
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http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+850&PAGE=Color&PgName=Color" target="_blank

PhaserLink™ Software

www.tek.com/Color_Printers/products/ phaserlink.html

View printer status using any web browser
Control printer settings

Link to online documentation via the World Wide Web

Requires network connection via TCP/IP

Tektronix web site

www.tek.com/Color_Printers/

®  Product and supplies information

m Finding your local reseller

TekSMART™ Knowledge Base

www2.tek.com/TekSMART/

Application issues

Networking issues

Printer errors

Print quality issues

Troubleshooting

Latest tips from technical support

User Guide
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Other online services

Anonymous ftp server

ftp.tek.com/Color_Printers/

Subscribe to email
update notices

www.tektronix.com/Color_Printers/support/

subscribe.html

Customer Support Centers

Australia
1-800-811-177

Austria
0660 5804
Belgium

02 720 9602

Brazil
0800 16 0220

Canada
1-800-835-6100

China
10-6235-1230

Denmark
(44) 533 444

Eastern Europe and
the Middle East
+44 1908 68187

Finland
0203 206 30

68

France
01 69 86 8137

Germany
0180 525 3535

Hong Kong
2585-6655

India (South Asia)
(91) 80-227-5577

Italy

02 45 287 000
Japan

81 3 3448 4872

Korea
2-528-4661

Luxembourg
400 847

Netherlands
(040) 267 0440

New Zealand
+61 2 9888 0100

Norway

22723 801
Singapore (ASEAN)
1-800-356-5565
Spain

902 239 272

Sweden
(08) 299 071

Switzerland
01 212 2212

Taiwan
(02) 2757-1571

Thailand
2-645-4407

U. K.
(01) 908 681 707

U.S.
1-800-835-6100
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Printer Management

Printer Management

PhaserLink Printer Management software

PhaserLink Printer Management software is a printer management tool that uses World
Wide Web technology to provide printer information and functionality:

Job status
Job accounting
Printer usage

Routine troubleshooting

Configuration of printer settings

PhaserLink requires a TCP/IP connection. To access PhaserLink information, enter your
printer’s IP address in a web browser. The PhaserLink interface appears on your
computer’s screen.

For detailed information on PhaserLink Printer Management software, refer to
“PhaserLink Printer Management software: The Printer’s Information Link” on the
printer’s CD-ROM or web site. Or enter this address in your web browser:

www.tektronix.com/Color_Printers/products/phaserlink.html

Job Accounting

The printer stores a log file containing information about jobs printed. The file is a list of
job accounting records. Each record contains fields such as user name, job name, pages
printed, job times, and ink used. Job accounting is available through the PhaserShare
Administrator and PhaserLink Printer Management software.

For more information on Job Accounting, see the PhaserShare Networking Manual on the
printer’s CD-ROM or web site.

TekSMART™ Knowledge Base

www2.tek.com/TekSMART/

Application issues

Networking issues

Printer errors

Print quality issues

Troubleshooting

Latest tips from technical support
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Printer Management

Usage Profile

Usage Profile provides a proactive strategy for service, maintenance, and administration of
your printer. With Usage Profile, you can keep track of most printer parameters in detail.

Information in the Usage Profile Report includes:

Remaining life of consumables
Paper versus transparency usage
Number and location of media jams

Media tray usage

Number of pages printed

Print the Usage Profile report from your printer’s front panel. Refer to the Menu Map for
location and instructions.

In addition, you can easily arrange electronic mail notification so that your system
administrator or supplies-ordering agent receives timely information on error conditions
or supplies status. This feature allows you to predict the ordering needs of customer-
replaceable consumables for remote locations. These types of error conditions are
reported:

B For the designated operator, system administrator or service provider

m  Supplies (customer-replaceable consumables) low or out
m  Empty media tray

B For the system administrator

m  Printer configuration

m  For the service provider

m  Error conditions requiring hardware service repair

For detailed information about the Usage Profile report, refer to the Tektronix web site.
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Fonts

Fonts

Resident typefaces (PostScript)

The printer accepts Adobe Type 1 and Type 3 downloadable fonts, TrueType fonts, PCL5,
and a variety of user-defined fonts.

To extend font capability, the printer supports an optional internal IDE hard drive for
storage of additional fonts. Refer to the printer’s user guide, or the Tektronix web site, for
ordering information.

ATM (Adobe Type Manager) software (provided on the printer’s CD-ROM) helps your
computer to display these fonts on screen as they will appear in your prints.

All printer configurations are shipped with 136 resident fonts. To print a sample of the
printer’s fonts, see page 74.

Resident typefaces (PCL5C)

For PCL5C (Printer Command Language) printing, the printer supports Courier, Times,
and Universe typefaces in medium, bold, italic medium, and italic bold. In addition,
there are 46 PCL fonts. The printer port must be set to AutoSelect (which is the default)
for the printer to accept PCL data.
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Fonts

Downloading fonts

Printer-resident fonts are always available for printing. Additional downloadable fonts
can be sent from your computer and stored in the printer’s memory or on a hard disk.
Adding more printer memory expands the number of fonts that can be stored on your
printer.

Downloading fonts saves print time when printing large, or several documents, that use
those fonts.

The printer accepts these (and other) downloadable fonts:

m Type1l
m Type3

[
m Agfa

m  Bitstream
m  Microsoft

m  Apple

m  TrueType (scalable to any point size; look the same on-screen and printed).

Before printing, make sure that the fonts specified in your document are installed in the
printer or are set up correctly. If you request a font in an application that is not resident in

the printer, or is not correctly installed, the text is printed in Courier typeface.

Refer to the printer’s user guide, or the Tektronix web site, for information on ordering a
hard drive for font storage.
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Fonts

Downloading fonts from a Macintosh

1. Refer to Downloading files to the printer from a Macintosh on page 95 to locate the
Apple Printer Utility on the printer’s CD-ROM.

Within the Apple Printer Utility, click Open Printer; a dialog box appears.
Click the arrow next to Printer Preferences.

For a list of installed fonts and locations, click the arrow next to Fonts.
Click Add.

Select your font folder, then select the font you want to download.

N o u s Wb

Under Destination, select the download location: either the printer’s memory or an
internal hard disk.

Click Add for one font or click Add All for all fonts in the folder.
9. Click Send; the font(s) appear in the list.

Note

To remove downloaded fonts, click Remove.
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Fonts

Printing a list of resident fonts

From a Macintosh

1.

2.

Refer to Downloading files to the printer from a Macintosh on page 95 to install and
use the Apple Printer Utility.

Within the Apple Printer Utility, from the File menu, select Print Font Samples.

From a PC or workstation

1.

74

Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

For Setup Type, select Custom.

Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.

Refer to Downloading files to the printer from a PC on page 97 for file downloading
instructions.
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Image Smoothing

Image Smoothing

Image Smoothing blends adjacent colors in low-resolution images for smoother color
transitions. For example, use Image Smoothing to improve the appearance of a 72-dpi
image downloaded from the World Wide Web. Image Smoothing is not recommended for
300-dpi or higher images.

There are four ways of selecting Image Smoothing (driver selections override all other
settings):

1. In a supported driver, locate the Image Smoothing option:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.5.1 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Expert Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Through the printer’s front panel; see the Menu Map for location.
3. Through PhaserLink Printer Management software.

4. Through one of the following PostScript utility files (see Printer Utilities on page 91
for instructions):

Macintosh

m  Image Smoothing On
m  Image Smoothing Off
PC

m  SMOOTHON.PS

m  SMOOTHOFF.PS
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Quick Collate

Quick Collate

Requirements
® DP or DX Feature Set

m Hard drive (internal)

Quick Collate speeds the collation and printing of large print jobs and multiple sets of
documents. The collate function in some software applications repeatedly sends each
page in sequence to the printer until the requested number of copies is printed. With the
Quick Collate option, the job is sent only once and then multiple collated sets are
produced by the printer, allowing much faster processing time.

The number of pages that can be collated at one time depends on the size of the hard disk
installed in the printer.

Note

Make sure that you turn off the collate function in your application, because the
printer’s Quick Collate option is faster than the collate function in software
applications.

In a supported driver, locate the Quick Collate option:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.5.1 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Advanced Paper Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

Quick Collate and 1st Page Preview

When you use the printer’s Quick Collate option with 1st Page Preview, only the first page
of the first set is printed before pausing for your review.
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Separation Pages

Separation Pages

You can have the printer insert a separation page, or divider page, to separate print jobs,
multiple copies of a single print job, or individual pages of a print job.

There are two selections to make in your printer driver.

1. In a supported driver, locate the Separation Page options:

m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.5.1 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Advanced Paper Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
From the Properties tab, select the Advanced tab. From the Document Options
tab, select Printer Features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Select one of the following for Separation Page:

m  Off: Turns off the Separation Page feature.
m  End of Job: Inserts a separation page between individual print jobs.

m  End of Set: Inserts a separation page between copies, or sets, of a multi-copy
print job.
m  End of Page: Inserts a separation page between every page of a print job.

3. Select one of the following for Separation Page Source:

m  Upper Tray: Takes paper for the separation page from the upper media tray.

m  Middle Tray: Takes paper for the separation page from the middle media tray, if
you have optional paper trays installed.

m  Lower Tray: Takes paper for the separation page from the lower media tray, if
you have optional paper trays installed.

Advanced Features and Troubleshooting Manual 77



PANTONE Colors

PANTONE Colors

For the latest information on color libraries, visit the Tektronix web site at:

www.tektronix.com/Color_Printers/

or contact your local Tektronix reseller.

PANTONE Color files for your printer include printer-specific color library files for some
specific applications and a file to print the PANTONE Color sampler chart.

Methods of printing PANTONE Colors

PANTONE Colors from color selection books

In some applications, you can select colors from PANTONE Color selection books. These
colors can be proofed on your Phaser printer before final output on a printing press. For
this method, the printer-specific PANTONE Color files are not required.

1.

From an application, select and apply PANTONE Colors; use individual color values
from a PANTONE Colors selection book.

Print your document; from a supported driver, select the Commercial Press color
correction. (Proof colors may not be completely accurate, but PANTONE Colors will
be printed correctly on a printing press.)

When you are satisfied with the proof, the file can be separated for printing press
plates without adjustment to the file.

Printer-specific PANTONE Colors

Your printer can produce process color simulations of PANTONE Spot Colors.

1.

Print a copy of the PANTONE Color chart. Refer to Printing the PANTONE Color
Chart on page 80.

Within an application, define the desired color in your document by using the
individual CMYK values which appear on the sampler chart.

Print your document. For best results, use the same printer settings for color
correction and print quality, and the same type of paper that you used to print the
PANTONE Color chart.

For final output on a color printing press

For colors to be printed as a process color (no spot colors), follow these steps:

1.
2.
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Open the application.

Before separating the file for printing press plates, replace the printer’s PANTONE
process Colors with standard PANTONE Colors.
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PANTONE Colors

Installing the PANTONE Color files

From the Web

1. Download the appropriate PANTONE Color file for your printer from the Tektronix
web site:

www.tektronix.com/Color_Printers/

2. Choose a directory location, and extract the file.
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Printing the PANTONE Color Chart

Macintosh

Printing individual pages from Acrobat Reader

1. You will need to install Acrobat Reader if you want to print individual pages from the
PANTONE Color chart. Insert the printer’s CD-ROM in your computer’s drive, go to
the Utilities folder, and install Acrobat Reader onto your computer’s hard disk; follow
on-screen instructions.

2. After Acrobat Reader is installed, locate the Pantone files you downloaded from the
web site. Double-click the desired PDF file.

3. View and print pages from the PDF file. For best results, print on paper.

Note

Print only with the None Color Correction setting; other settings cause
PANTONE Colors to print differently than expected.

Printing the entire chart

80

Use the Apple Printer Utility to download to the printer the desired PANTONE Color
PostScript file, refer to page 91 for instructions. This PostScript file contains
necessary color correction and print quality settings.

For best results and truest color:

m  Print the chart on paper that is similar to the paper that will be used on the
printing press.

m  Turn off two-sided printing when printing the color chart in order to reduce the
effects of color show-through.
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PC

Printing individual pages from Acrobat Reader

1. You will need to install Acrobat Reader if you want to print individual pages from the
PANTONE Color chart. Insert the printer’s CD-ROM in your computer’s drive, go to
the Utility directory, and install Acrobat Reader onto your computer’s hard disk;
follow on-screen instructions.

2. C(Click Start, then Programs, then the program folder you selected; the default is the
printer’s name.

Select the PDF file.
4. View and print pages from the PDF file. For best results, print on paper.

Note

Print only with the None Color Correction setting; other settings cause
PANTONE Colors to print differently than expected.

Printing the entire chart

Print the PANTONE Color chart by sending the PANTONE PostScript file to the printer.
Refer to page 91 for downloading instructions.

m For best results and truest color:

m  Print the chart on paper that is similar to the paper that will be used on the
printing press.

m  Turn off two-sided printing when printing the color chart in order to reduce the
effects of color show-through.
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PhaserPrint Plug-in for Photoshop

The PhaserPrint™ plug-in, included on the printer’s CD-ROM, operates within the
Photoshop application. With PhaserPrint, you can improve image transfer time and gain
easy access to Tektronix printer features and other media features.

PhaserPrint software produces correct output only on supported Tektronix printers.

Note

If you use this plug-in with a printer not listed in the PhaserPrint dialog box, the
image may be placed incorrectly on the page, or colors may look incorrect, or
your file may not print.

Installing the plug-in: Macintosh

Note

The PhaserPrint Plug-in is automatically installed with the software installation
option Easy Install.

Compatibility requirements
m  Photoshop 2.5.1 and higher
m  System 7.0 and higher

Installing the plug-in
1. From the printer’s CD-ROM, run the Installer application. Select Custom Install.

2. Select PhaserPrint plug-in for Photoshop. Click Install; the file is installed in the
Photoshop application’s Plug-ins folder on your computer’s hard disk.
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Installing the plug-in: Windows

Compatibility requirements

m  Photoshop 4.0 and higher

®m  Windows 95/Windows 98 or Windows NT

m (optional) TCP/IP support requires proper installation of IP networking software and
cards

Installing the plug-in

1. Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

2. For Setup Type, select Custom.

Click Next until the Chose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Printer Driver
m  Sub-components: Photoshop plug-in

4. Follow the on-screen instructions to complete the installation.
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Using the plug-in

1.

84

If you don’t already have a default printer selected, do the following:

oo

S

Macintosh:
Open the Chooser.

Select a PostScript driver (such as the Apple LaserWriter 8); select your printer.
PhaserPrint software works like a printer driver, and prints to the printer you
selected in the Chooser.

Windows:

Click Start, then Settings, then Printers.
Right-mouse-button-click on your printer’s icon.
In the pop-up menu, select Set as Default.

Within the PhaserPrint software, select your printer and port, as described in
Print using (Windows) on page 86.

Open Photoshop. Open an image file.

From the File menu, select Export. Select PhaserPrint; the PhaserPrint dialog box
appears.

In the Printer Model field, select your printer.

PhaserPrint software supports the following image modes selected from Photoshop’s
Mode menu. If you select a mode not listed here, an error message appears and your
image is not printed.

Bitmap
Grayscale
Indexed Color
RGB Color
CMYK Color
Lab Color
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Selecting options in the PhaserPrint dialog box

Settings you make in the PhaserPrint plug-in remain in effect until you change them. The
exception is Number of Copies, which defaults to 1 each time you start the plug-in.

Note

You can get information on any of the plug-in’s features or printer-specific
options with the online Help function.

Number of copies

Enter the number of copies to print, from 1 to 1000.

Print using (Macintosh)

The Print using pop-up menu lets you choose between printing an image or saving the
image to disk.

m  AppleTalk: Prints the image to the printer currently selected in the Chooser; the
currently selected printer name is displayed in the Printer model field. If the selected
printer is not a PostScript printer, this option is unavailable (grayed-out).

B PostScript file: Saves an image to disk as a PostScript file. Click Save; a dialog box
lets you choose a new or existing file for saving the PostScript code.

When selected, the File format pop-up menu becomes available. This pop-up menu
has two options: ASCII base-85 and Binary.

m  ASCII base-85: Image data is encoded using an ASCII base-85 filter during file
output, making the resulting PostScript file portable, and downloadable through
interface ports that don’t support binary data. Note that the file may be up to
25% larger.

m  Binary: Image data is output in binary format.
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Print using (Windows)

The Print using pop-up menu lets you choose between printing an image or saving the
image to disk. It has two to four options, depending on your system configuration:

TCP/IP: Available if a TCP/IP stack is installed and running. From Printer model,
choose a printer. Add and delete printers in the list, and edit the printer
configurations. TCP/IP is the fastest printing method; it prints jobs in much less time
than the Local Port or Printer Driver methods, and is the recommended method if it is
available for the printer you are using.

Local Port: Available if you have local ports installed in your PC. From the Port
Name, choose the desired printer port.

Printer Driver: Prints the image through the selected printer driver. From Driver
Name, choose a printer.

PostScript file: Saves an image to disk as a PostScript file. Click Save; a dialog box
lets you choose a new or existing file for saving the PostScript code.

When selected, the File format pop-up menu becomes available. This pop-up menu
has two options: ASCII base-85 and Binary.

m  ASCII base-85: Image data is encoded using an ASCII base-85 filter during file
output, making the resulting PostScript file portable so that it can be downloaded
through interface ports that don’t support binary data. Note that the file may be
up to 25% larger.

m  Binary: Image data is output in binary format. Recommended for network
printing only (not for the parallel port).

Printer model

Displays the currently selected printer.
Lists all printers supported by PhaserPrint software.

When you select your printer model, PhaserPrint displays the correct options for your
printer.

Media size (selection)

Paper sizes are printer-specific; refer to the online Help for your printer’s options.
Before selecting a paper size, select your printer in the Printer model field.

Color Correction
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Color Corrections are not available if Lab is the selected Mode in Photoshop.

If RGB is the selected Mode in Photoshop, the Calibrated RGB option is also
available.
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Media

B The setting remains in effect until you change it.

Quality

B The setting remains in effect until you change it.

Rendering Intent

m  Available in the following cases:

m  If the Mode in Photoshop is RGB, and you select Calibrated RGB as the Color
Correction in PhaserPrint.

m  If the Mode in Photoshop is Lab.

m Calibrated RGB and Lab modes take longer to print than other modes because the
printer must convert CIE colors to RGB or CMYK colors before printing.

Compress Image Data

m  Compresses image data so that less data is sent to the printer or stored in a file.

m  Useful if your network connection is slow, for example, if you are connected to a busy
network or if you are using a parallel port. For fast networks, printing may be faster
without using this option.

B The setting remains in effect until you change it.

Default is On.

Fast preview
Quick print of your image with slightly reduced image quality.
Reflects the printer color correction you selected.

For the fastest printing, use the None color correction option.

Default is Off.
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1st Page Preview

Available only with the printer’s DP or P, and DX Feature Set options.

When sending a multiple-copy print job to the printer through the driver, you can
select 1st Page Preview to preview the first page of the job, and determine if the job is
printing as expected before proceeding with the remainder of the job. This option is
especially useful when printing many copies.

a. Click the 1st Page Preview check box.

b. Check your first print. At the 1st Page Preview message on the printer’s front
panel, select one of the following:

m  Reprint: Reprints the first page, the printer pauses again for the duration of the
selected timeout, or until you press one of the buttons.

m  Cancel: Cancels the print job.
m  Continue: Continues printing the entire job.

At the printer’s front panel, set the 1st Page Preview timeout.

Default is Off.

Image Smoothing

Blends adjacent colors so that color transitions are less noticeable.

Use this option when the image being printed was scanned at a lower resolution than
the printer’s output resolution. For example, printing an image scanned at 72 dpi
using the printer’s Standard print quality mode.

Images printed using Image Smoothing appear with less sharp detail but with
smoother color transitions.

Default is Off.

Stylized representation of the page
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The lower left area of the dialog box displays a stylized representation of the page as it
would look when printed using the current selections in the Scale, Scale to fit,
Printer model, Media size (selection), Landscape orientation, Replicate images,
Center images, and Image separation options. When you change any of these
selections, the representation of the page is redrawn to reflect the new selection.

If Show color preview of image is On, an approximate color image is displayed.
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Scaling an image
B Scale to fit

m  Scales an image to the largest size that fits the image area of the currently
selected page size or orientation.

m  Automatically updates the Scale field value.
B Scale

m  Type the percentage the image should be scaled, from 10 percent to
2000 percent.

m  Use with the Replicate images option to produce multiple copies of an image on
a single page.

m  Alert message: Image clipping will occur.

This message appears in the PhaserPrint dialog box whenever a scaled image will not
fit within the image area of the currently selected page size or orientation option.

Landscape orientation

m  Prints the image horizontally (landscape) on the page. Leave this box unchecked to
print the image vertically (portrait) on the page.

m  Refer to the Stylized representation of the page, in the lower left corner of the dialog
box, to see how your selection will look when printed.

Center images

B Centers the image in the page’s image area.

m  If this box is not checked, the lower left corner of the image is aligned with the lower
left corner of the printable area of the page.

m  If the Center images box is checked and the Replicate images box is checked, the set
of replicated images are centered in the image area of the page.

Replicate images
m  Fills the page’s image area with as many copies of the image as will fit.
m  The size of each replicated image is determined by the setting in the Scale text box.

m  If the size of each replicated image (shown as black rectangles in the stylized
representation of the page) is too small to display, the total image area of the printed
page is shown as a single gray rectangle.

Image size

m  Reflects the dimensions, in inches or millimeters, of the image.

m  Ifthe value in the Scale box is out-of-range, the image dimensions are displayed with
question marks.

Advanced Features and Troubleshooting Manual 89



PhaserPrint Plug-in for Photoshop

Image separation

Only available if the Replicate images box is checked.

Type an amount, in inches or millimeters (depending on your measurement
standard), to specify the amount of separation between
each replicated image.

A larger amount reduces the number of images that can be printed at one time.
Minimum allowed separation value is 0.

Maximum separation value is 100 mm (4 inches).

Default separation value is 3.175 mm (0.125/one-eighth inch).

Valid characters for this field are 0 to 9 and a period (or decimal point).

As you type a value, the stylized representation of the page, and Number of
images and Image layout values are dynamically updated. If the value entered in
the Image separation field is out-of-range, the values in these other fields are
replaced by question marks, and no images are shown in the stylized
representation of the page. If the value is out-of-range, and you click Print or
Save, the following alert is displayed:

The value for Image separation is out of range. It will be replaced with the
closest allowed value.

Number of images

Displays the number of scaled images that will fit in the image area of the currently
selected Media size (selection) and Landscape orientation options.

Number of images reflects the current Image separation value.
If the Replicate images box is not checked, this number is set to 1.

If either Scale or Image separation values are out-of-range, a question mark is
displayed.

Image layout

Shows how the scaled images will fit horizontally and vertically in the image area of
the currently selected Media and Landscape orientation options.

Image layout reflects the current Image separation value.

If the Replicate images box is not checked, this number is set
tolx1.

If either Scale or Image separation values are out-of-range, question marks
are displayed.

Media size (display)

Reflects the dimensions, in inches or millimeters, of the selected media size.

Show color preview of image

Displays an approximate color image, rather than a black box, in the Stylized
representation of the page field.
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Printer Utilities

In addition to using the printer’s front panel or the options in a supported driver, the
printer’s utility files offer another method for changing the way the printer operates.
In some cases, a selection can only be made with a utility file.

Utility files control print features such as color correction and enabling or disabling the
Startup Page. However, printer features that are selected from a driver override utility file
settings and front panel settings.

There are three places to locate utility files:

The printer’s CD-ROM

Tektronix’ ftp site

Tektronix’ World Wide Web site

Phaser Hard Drive (if internal IDE Hard Disk is installed)

Files can be downloaded to the printer:

m From a Macintosh

m From aPC
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Locating the files on the printer's CD-ROM

Installing the utility files for Macintosh

To install the Apple Printer Utility and the Samplers (color charts):

1. From the printer’s CD-ROM, run the Installer application. Select Easy Install.
2. In the PhaserTools folder on your computer’s hard disk, locate the Samplers (color
charts) and the Apple Printer Utility.

To install the printer’s utility files:

1. On the printer’s CD-ROM, locate the PhaserTools folder, then the Printer Utilities
folder.

2. Copy the Printer Utilities folder, or individual files, to your computer’s hard disk, or
use the files from the CD-ROM.

Installing the files for PC

Locating the printer’s utility files:
1. Insert the printer’s CD-ROM into the CD-ROM drive.

m Ifthe Windows autorun feature is enabled, the CD-ROM launches automatically.
At the opening screen, click Exit.

2. In the taskbar on your screen, click Start, then Programs, then Windows Explorer.
Select the CD-ROM.

3. Locate the utility files on the CD-ROM in the phsrxxx folder inside the utility folder
(where phsrxxx is your printer’s name). Use the files on the CD-ROM or copy the files
to your computer’s hard disk.

Installing the Sampler (color charts and font sampler) files:

1. Insert the printer’s CD-ROM into the CD-ROM drive.

m If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

2. For Setup Type, select Custom.

3. Click Next until the Choose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

4. Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.
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Locating files on the Tektronix World Wide Web site

Tektronix has a site on the World Wide Web that you can reach from a web browser, at the
following address:

www.tek.com/Color_Printers/

At the Tektronix Color Printer home page, explore options such as customer support
documents and new product information. New and updated information is always being
added, so check the web site frequently.

Use a web browser such as Netscape Navigator, and follow these steps.

1. Start your web browser and enter the following address:

www.tek.com/Color_Printers/support/software.html

2. From the pull-down menus, select your printer, computer, and type of file.

3. Select the files you need; they are downloaded to your computer.
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Locating files on the Tektronix FTP server

Utility files included on the printer’s CD-ROM let you set up the printer from UNIX and
VMS workstations to select between media trays, print quality modes, color correction
modes and other features. If you don’t have the means to transfer these files from the
CD-ROM, you can request files from the Tektronix anonymous ftp server.

If you can exchange electronic mail with other Internet sites, you can access the Tektronix
ftp server. From this server you can retrieve driver and utility files and color printer
information either with a web browser or command prompt.

From a web browser:

1.
2.

3.
4.

Start your web browser application.
Type this address:
ftp://ftp.tek.com/

From the pull-down menus, select your printer, computer, and type of file.

Select the files you need; they are downloaded to your computer.

From the command line:

1.
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At the system prompt, type the following: ftp ftp.tek.com
The system responds: Name (ftp.tek.com:<login name>):

Type: anonymous. Press Return.
The system responds: Guest login ok, send your complete e-mail address as
password.

Enter your e-mail address. Press Return.

Change directories to your printer-specific directory:
cd Color_ Printers/UNIX/Phaser 850/utilities

Download the utility files; type: mget *
The system prompts you for each file in the directory, to which you respond y (yes)
or n (no).

Exit the ftp session: type quit or bye; press Return.
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Downloading files to the printer from a Macintosh

Using the Apple Printer Utility to download files

All PostScript utility files on the printer’s CD-ROM can be downloaded to the printer with
the Apple Printer Utility.

o1

—
Apple Printer Utility

To download PostScript utility files, follow this procedure:

1.

From the PhaserTools folder on your computer’s hard disk, double-click Apple
Printer Utility.

In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.
m  Under Printers, select your Phaser printer.
m  Click Open Printer.

From the File menu, select Send PostScript File; the Select the PostScript files to
download dialog box appears.

Select the folder location of the PostScript file(s) that you want to download. The
printer’s PostScript utility files are located on the CD-ROM in the Printer Utilities
folder inside the Phaser Tools folder.

Select a utility file. Click Add.
Click Send.

At the prompt Save PostScript output as, you are asked for a file name for saving
printer output. Use the default name given in the edit box or type a new name.
(Printer output includes status messages generated by the printer reporting such
conditions as out of paper.)

Click Save.

If no output is returned by the printer, the Apple Printer Utility displays a dialog box;
click Continue. If output is returned by the printer, you won't see this dialog box.

Check your computer’s hard disk for the message file created by the utility.

To download fonts, see page 73 for additional information.

To print a font sampler, see page 74 for additional information.

To download color sampler charts, see page 106 for additional information.
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Using the Apple Printer Utility to perform other tasks

In addition to downloading PostScript files and fonts, you can use the
Apple Printer Utility to perform the following specialized tasks.

Note

If your printer is connected through a print server, you can only use the Apple
Printer Utility to download PostScript utility files.

Turning on/off the Startup Page
1. Double-click Apple Printer Utility.

2. In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.
m  Under Printers, select your Phaser printer.
m  Click Open Printer.

3. Click the arrow next to Printer Preferences; a list of options appears.
4. C(Click the arrow next to Startup Page.
5. Click one of the following:

m  On: Prints a Startup Page each time the printer is turned on or reset.
m  Off: Stops the Startup Page from automatically printing.
6. Click Send.

Changing the printer’s AppleTalk name
1. Double-click Apple Printer Utility.

2. In the Printer Selector dialog box, make the following selections:

m  Under AppleTalk Zones, select your printer’s zone.

m  Under Printers, select your Phaser printer.

m  Click Open Printer.

Click the arrow next to Printer Preferences; a list of options appears.

Click the arrow next to Name.

In the text box, type the new printer name.

Click Send.

o v W
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Downloading files to the printer from a PC

Downloading files from Windows 3.1

1. Select the utility file you want to send to the printer, for example RESET.PS.

2. From the File menu, select Copy; the Copy dialog box appears with the utility file you

selected listed in the From field.

3. In the To field, type the port your printer is connected to. For example, type LPT1:
for a parallel port connection. Click OK.

4, If the Confirm File Replace dialog box appears, click Yes to continue; the file is
downloaded to the printer.

Downloading files from Windows 95 / Windows 98

1. Select the utility file you want to send to the printer, for example RESET.PS.
2. In the taskbar on your screen, click Start, then Programs, then MS-DOS Prompt.

m  Change directory to the location of the utility files.

m  If your printer is connected to the parallel (LPT) port, type the following
command (where xis 1, 2, or 3): COPY RESET.PS LPTx:

Downloading files from Windows NT

1. Select the utility file you want to send to the printer, for example RESET.PS.
2. In the taskbar on your screen, click Start, then Programs, then MS-DOS Prompt.
m  Change directory to the location of the utility files.

m  If your printer is connected to a network, type the following command:
Ipr -S <IP Address> -P PS RESET.PS
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Downloading files if your printer is connected to a Novell Netware
network

This procedure lets you redirect (capture) LPT ports in Novell NetWare. NetWare queues
can be captured from the DOS Prompt or captured directly from Windows. To find out if
an LPT port is already captured, type the following command from the DOS Prompt:
capture show

This will list the current capture data for each virtual port.

Note

If an ad command or file name error occurs, run the command from the file
servers Public directory.

m  For NetWare 3.xx and Netware 4.xx bindery queues:
capture g=[queue_name] l=[port] nb nff nt

where queue_name is the name of the queue to be captured, and port is the virtual
port to capture to, such as LPT3.

Also, nb is no banners, nff is no form feeds, and nt is no tabs.

For example: capture g=phaser_350 1=3 nb nff nt

Note

For NetWare 4.xx NDS queues, the queue name needs to start with a period. For
example: capture g=.phaser_350_g.nds.printers.support 1=2 nb nff nt.

m  For Windows 95 / 98 environments follow these guidelines:
1. From the Details tab of your printer’s driver, select the Capture Printer Port button.
2. Select the appropriate virtual port under the Device field.

m  For bindery queues, enter the path as \\server_name\queue_name and select
OK. For example: \\nw_server\Phaser_350

m  For NDS queues, enter the path as \\Tree\queue_name.context and select OK.
For example: \\Tek\.Phaser_350_Q.nds.printers

m  For Windows 3.1x environments follow these guidelines:
1. From the Windows Control Panel, select Printers.
2. Select the Connect button, then select the Network button.

3. Choose a Port to capture, then locate the appropriate queue.

Note

If the appropriate file server is not listed, click the Attach button and select the
desired file server. Login and click OK. Within the Operation section, check the
box next to the word Permanent, then click Connect. The port should then be
captured.
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Downloading files if your printer is connected through PhaserPort

This procedure lets you create the printer and then redirect the port, turning client #1 into
a print server.

1. On Client #1, create a printer using the LPT1 port.

2
3.
4.
5

b
c.
d

Share the printer to the network.
Install Phaserport and switch the LPT1 port to the Phaserport port.
On client #2, browse the network and install the shared printer.

Open the printer's Properties.

Click Start, select Settings, and then select Printers.
Right-mouse-click on the printer's icon.

In the pop-up dialog box, select Properties.

In the Details tab, click Capture Port and enter the path.

Downloading files if your printer is connected to Windows NT

This procedure lets you redirect (capture) LPT Ports

Under Windows NT print spooler, you create Ports based on their physical location:

However, if you’re at a command prompt (DOS Prompt) and want to print, or copy, a

Local ports = Lpt1 / Lpt2, etc.

IPX Port = \\NW_SERVER\Phaser
Appletalk Ports = WV Net 36:Phaser
TCP/IP Ports = 162.36.62.151:PS or [AUTO]

PostScript file to a port that is a network port, you can do the following:

m TCP/IP Ports:

Ipr -S [printers IP Address] -P [print queue] filename
For xxample: lpr -S 134.62.36.70 -P PS test.ps

m IPX and Appletalk ports require the redefinition of the LPTX port to the network path
through the use of the NET USE command.

NET USE LPT1 \\Server Name\Queue_ Name
For example: NET USE LPT1 \\NW_SERVER\Phaser
or: NET USE LPT2 \\NT_SERVER_NT\Phaser

After redirecting the port using the NET USE command you can use the COPY
command to print the postscript file.

eg. C:\> COPY TEST.PS LPT1:
When finished, end the redirect with the command:
NET USE LPT1 /delete
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Advanced Printing Features for
Phaser 850 Printers

Previewing with 1st Page Preview

When printing multiple pages through the driver (either multiple copies of a single page or
a multiple-page file), select 1st Page Preview to preview the first page of the job before
proceeding with the remainder of the job; this feature is useful when printing a large job.

You can set the timeout in the printer’s front panel (timeout is the amount of time the
printer waits after sending the first page of a file before it continues with the remainder of
the job). The default timeout is 5 minutes.

Requirements
m DP or DX Feature Set

B Turn on the feature in the printer driver

Use 1st Page Preview

1. Inasupported driver, select 1st Page Preview:
m  LaserWriter 8.3.4 driver:
In the Print dialog box, click Options.

m  LaserWriter 8.5.1 driver:
In the Print dialog box, from the pull-down menu (General) select Printer
Specific Options.

m  Windows 95 / Windows 98 PostScript driver:
Start/Settings/Printers, then select Properties for your printer. In the Setup tab,
select Expert Options.

m  Windows 2000 driver:
From the Layout tab or Paper/Quality tab, click Advanced.

m  Windows NT driver:
Under the Properties tab, select the Advanced tab. In the Document Options tab,
select Printer features.

m  Adobe PS3 driver for Windows 3.1:
Select the Features tab options.

2. Check your first print. At the printer’s front panel 1st Page Preview message, choose
one of these options:

m  Reprint: Reprints the first page, pauses for the duration of timeout or until you
press a button.

m  Cancel: Cancels the print job.
m  Continue: Prints the rest of the print job.
3. Press Select.
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Reset the timeout

1. In the front panel, scroll to Menu; press Select.

2. Scroll to Printer Configuration; press Select.

3. Scroll to Default Printer Settings; press Select.

4. Scroll to 1st Page Preview Timeout; press Select.

5. To change the timeout (the amount of time the printer pauses before completing the
print job), press the up or down arrows; press Select.

6. To exit, scroll to Exit and press Select.

Note

You can also control the default timeout for 1st Page Preview through
PhaserLink Printer Management software. For details on PhaserLink Printer
Management software, refer to the PhaserShare Networking Manual on the
printer’s CD-ROM or Tektronix web site.
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Automatic tray switching

When your printer has a High-Capacity Paper Tray Assembly, you can easily run large jobs
without having to replace paper often. The printer automatically takes paper from the
next tray when the first tray runs out.

1.

For automatic tray switching to work properly, load the same type and size paper in
all of the printer’s paper trays.

Install a tray in each of the printer’s tray slots.

In the printer driver, select Paper as the source.

Front Panel Intensity

You can adjust the intensity of the front panel’s back lighting.

1.

2
3.
4
5

In the printer’s front panel, scroll to Menu; press Select.
Scroll to Printer Configuration; press Select.

Scroll to Default Printer Settings; press Select.

Scroll to Set Front Panel Intensity; press Select.

To change the front panel back light intensity (0 is no back light, 10 is the brightest
back light), press the up or down arrows.

To activate your selection, press Select.

To return to the Ready to Print message, scroll to Exit; press Select.

Intelligent Ready mode

Intelligent Ready mode is an automated system that monitors the printer’s usage and
warms up the printer when you are most likely to need it. You can set Intelligent Ready
mode with PhaserLink or the printer’s front panel. The front panel only allows you to turn
Intelligent Ready mode On or Off; use PhaserLink to make other settings.

N o o ok wbd e

In the printer’s front panel, scroll to Menu; press Select.
Scroll to Printer Configuration; press Select.

Scroll to Default Printer Settings; press Select.

Scroll to Advanced Printer Settings; press Select.

Scroll to Intelligent Ready.

Press Select to turn this option On or Off.

To return to the Ready to Print message, scroll to Exit; press Select.

Note

You can also turn on the Intelligent Ready mode and set your own printer
warm-up times through PhaserLink Printer Management software. For details on
PhaserLink Printer Management software, refer to the PhaserShare Networking
Manual on the printer’s CD-ROM or Tektronix web site.
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Color Sampler Charts for
Phaser 850 Printers

Overview

Color sampler charts are colored rectangles with each color’s component values; they help
you select colors in an application that can be reproduced on your printer.

Component values are percentages of each color — CMYK (Cyan, Magenta, Yellow, Black),
RGB (Red, Green, Blue), or HSB (Hue, Saturation, Brightness) — that combine to make a
particular color.

W
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Color charts

m  Which color chart you print and use depends on how your application selects color.
For information on color selection, refer to the application’s documentation, then
print one or more of the color sampler charts.

m  Each color sampler chart is several pages long; print them in panels and connect them
to form a wall chart or place in a binder for easy reference.

Color sampler chart descriptions

Number of Utility Front PhaserLink
Color sampler chart pages * file panel'
selection
CMYK Sampler Cyan, magenta, yellow, and 18 X X X
black color model
RGB Sampler Red, green, and blue color 12 X X X

model

Hue, saturation, and
brightness color model

HSB Sampler

12 X

* The number of pages will be half with two-sided printing.

Note

To print the PANTONE Color sampler chart, refer to Printing the PANTONE

Color Chart on page 80.
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Printing a color sampler chart from the Phaser 850
printer’s front panel

Note

Use the same color correction and print quality mode to print the chart and to
print from your application. Any other color correction or print quality mode
selections in the driver will cause colors to print differently than expected.

Selecting a color correction and a print quality mode

1. From the printer’s front panel, use the up and down arrows to scroll to Menu;
press Select.

Scroll to Printer Configuration; press Select.
Scroll to Default Printer Settings; press Select.

Scroll to TekColor Correction; press Select.

u & W

Scroll to the color correction you want; press Select. A checkmark appears next to
your selection.

Scroll to Previous Menu; press Select.
Scroll to Print Quality Mode; press Select.

8. Scroll to the print quality mode you want; press Select. A checkmark appears next to
your selection.

9. Toreturn to the Ready to Print message, scroll to Exit; press Select.

Printing a color sampler chart
1. From the printer’s front panel, scroll to Printer Demo and press Select.
2. Scroll to the desired color sampler, then press Select. The color sampler prints.

3. Toreturn to the Ready to Print message, scroll to Exit; press Select.

Printing the desired colors from an application

1. Using the color sampler chart that you printed earlier, select the desired colors.

2. From your application, apply the desired colors in your document by entering the
specific CMYK or RGB values as indicated on the sampler chart.

3. Print your document; select the same color correction and print quality mode that you
used to print the color sampler chart.
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Printing the color sampler charts with utility files

From a Macintosh

1.

Refer to Downloading files to the printer from a Macintosh on page 95 to install and
use the Apple Printer Utility. The color sampler charts are also installed during Easy
Install.

Within the Apple Printer Utility, locate the color sampler chart files in the
PhaserTools folder on your computer’s hard disk and download them to the printer to
print.

From a PC or workstation

1.

106

Insert the printer’s CD-ROM into the CD-ROM drive.

m  If the Windows autorun feature is enabled, the CD-ROM launches automatically.

m  If the Windows autorun feature is disabled, double-click My Computer, then
double-click the CD icon to launch the CD-ROM.

For Setup Type, select Custom.

Click Next until the Chose Components and Sub-components dialog box appears.
Make the following selections:

m  Components: Graphics Arts Files
m  Sub-components: Samplers

Follow the on-screen instructions to complete the installation.

Locate the files in the folder you selected during the installation; the default is:
C:Program Files\Tektronix\Phaser xxx, where xxx is your printer’s name.

Refer to Downloading files to the printer from a PC on page 97 for file downloading
instructions.
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Troubleshooting Phaser 850 Printers

Useful tools

Printer CD-ROM

Advanced Features and Troubleshooting Manual
Consumables instructions

Setup Guide poster

Video help

Networking manuals

Cleaning instructions

Repacking instructions

Printer drivers

Material Safety Data Sheets (MSDS)

Windows driver help system

Install the driver from the printer’s CD-ROM and use the embedded help system.

m  Troubleshooting information
m  Access to installed manuals and videos

m Live links to the Tektronix web site

Color Connection

colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of your color printer:

Customized support and automatic driver update notification.
Color education with interactive tutorials and helpful hints.
Free templates and promotions.

Online supplies ordering

Online documentation.

Printer’s front panel

Help menu: Accesses information and tools for solving printer problems.

m  Help button: Press at any time for additional information on displayed menu options
or status messages.

B Troubleshoot Jams menu: Appears when paper jams, provides additional
information.
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Internal printer pages

The printer has several help pages available; refer to the Menu Map for their locations.

Connection Setup: connecting to a computer or network
Diagnostic Test Page: how to solve print problems, such as smudges or light stripes
Help Guide: Provides specific help resources.

Paper Tips Page: what papers, transparencies, or labels to use

Supplies Page: part numbers and descriptions

PhaserLink™ Software

www.tek.com/Color_Printers/products/phaserlink.html
View printer status using any web browser
Control printer settings

Link to online documentation via the World Wide Web

Receive electronic mail when consumables are low or other printer maintenance is
required

m  Requires network connection via TCP/IP

Tektronix web site

www.tek.com/Color_Printers/

®  Product and supplies information

m Finding your local reseller

TekSMART™ Knowledge Base

www2.tek.com/TekSMART/

Application issues

Networking issues

Printer errors

Print quality issues

Troubleshooting

Latest tips from technical support

Other online services

Anonymous ftp server ftp.tek.com/Color_Printers/

Subscribe to email update notices www.colorconnection.tektronix.com
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Front panel messages

Power indicator is blinking

Troubleshooting Phaser 850 Printers

Possible Causes

Solution

The printer is receiving, processing or printing
a job.

Wait for the job to be completed or cancel
the job.

You have entered the menu in the front panel.

Exit the menu.

Warm-up sequence has not finished.

Wait until the printer displays Ready to Print.

Power indicator is off

Possible Causes

Solution

The printer is turned off, is not ready, is
disabled, or has detected an error.

m Make sure that the printer is plugged in and
turned on.

m Do not plug the printer’s power cord into a
power strip; use a wall outlet.

Error indicator is blinking

Possible Causes

Solution

The printer is stopped because it detected an
error or condition requiring user intervention,
such as an open door or a media jam.

m Correct the condition reported by the front
panel (for example, close the door or clear the
media jam).

m Press the Help button to access information on
the error condition.

m Turn the printer off and unplug the power
cord for 1 minute. Then plug in the power
cord and turn on the printer.

m If the problem is an error that is not
user-correctable, contact Customer Support.

Returns to Ready to Print without any intervention

Possible Causes

Solution

Front-panel timeout: If no activity occurs in
2 minutes, the front panel returns to
Ready to Print.

Scroll to Menu and press Select to re-enter
the menu.
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Media Jam messages

Possible Causes

Solution

Media jam.

m Make sure that paper or transparencies are
installed correctly and that the tray’s media
indicator switch has been set correctly.

m When using the manual feed slot, make sure
that the media is fed straight and aligned with
the left edge of the manual feed slot.

m To clear the jam: Refer to the printer’s front
panel Troubleshoot Jams menu for
instructions.

Too much media is loaded in the media tray.

Reduce the amount of media to below the tray’s
maximum-capacity label.

Media is wrinkled or curled.

Change the media.

Media is too thick or too thin.

Use recommended media; refer to the printer’s
user guide, or print the Paper Tips Page (see the
Menu Map for location.)

Media has jammed at the manual feed slot
because it was not loaded properly.

Re-insert the media in the manual feed slot:

m Make sure the sheet is loaded flush against the
left side of the manual feed slot.

m Feed only one sheet at a time.

m Insert the sheet until it is pulled into the
printer.

Media Jam - Retry manual feed

Possible Causes

Solution

An envelope has jammed because it was not
loaded properly.

Re-insert the envelope in the manual feed slot:

m Make sure the envelope is loaded flush against
the left side of the manual feed slot with the
flap side facing up. Refer to the diagram on
the manual feed slot for instructions.

m When prompted by the front panel, feed one
envelope only.

A sheet of paper has jammed because it was not
loaded properly.

Re-insert the sheet in the manual feed slot:

m Make sure the sheet is loaded flush against the
left side of the manual feed slot. Refer to the
diagram on the manual feed slot for
instructions.

m When prompted by the front panel, feed one
sheet only.

Output tray full

Possible Causes

Solution

Too much media is stacked in the output tray.

Remove all printed pages from the output tray.
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Possible Causes

Solution

An incorrect paper size is loaded in the tray, or
paper narrower than the driver selection is in
the manual feed slot.

m Use only supported paper, transparency, and
envelope sizes.

m Make sure the size matches the driver
selection.

Ink low - Add ink

Possible Causes

Solution

One or more colors of ink are almost empty.

Add ink soon.

Out of ink

Possible Causes

Solution

One or more colors of ink are empty.

Add ink to continue printing.

Ink sticks jammed

Possible Causes

Solution

One or more ink sticks are stuck in the m Open and close the top cover.
ink-loading bin. m Press each row of ink sticks in the ink-loading
bin to make sure they are not jammed.
m Do not use broken ink sticks.
m Install ink sticks with the tapered side down.
Maintenance Kit Low
Possible Causes Solution

The Maintenance Kit is almost empty.

Order a replacement Maintenance Kit.

Maintenance Kit Empty

Possible Causes

Solution

The Maintenance Kit is depleted.

m Replace the Maintenance Kit to continue
printing.

m If message remains after new kit is installed,
make sure the new counter is also installed.
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Maintenance Drawer (A) locked

Possible Causes

Solution

Hot ink is present.

Close the door and wait a few minutes before
removing the maintenance drawer (A) from the
printer.

Maintenance Drawer (A) Missing

Possible Causes

Solution

Maintenance counter is not installed.

Install the counter.

Maintenance Drawer is not installed.

Install the Maintenance Drawer.

Maintenance Kit Service Life Low

Possible Causes

Solution

The 2-year service life is soon to expire.

Replace Maintenance Kit soon.

Maintenance Kit Service Life Expired

Possible Causes

Solution

The 2-year service life has expired.

Replace Maintenance Kit now.

Printer Error ##

Possible Causes

Solution

An error occurred that may not be
user-correctable.

Turn the printer off and unplug the power cord
for 1 minute. Then plug in the power cord and
turn the printer back on.

If the error is not cleared, write down the error
number.

m If you have access to the World Wide Web,
look up the error number on the TekSMART
web page (see Useful tools on page 107) for
possible corrective action.

m If the error persists, call Customer Support
with the error number. See the printer’s user
guide for instructions.
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Problems with automatic two-sided printing

Output is single-sided
m  Make sure that you have selected two-sided printing in the printer driver.
m  Use Letter- or A4-size paper only.

m  Make sure the switch on the standard Paper/Transparency tray is set to Paper.

Frequent jams with two-sided printing

m  Paper must be between 60 - 150 g/m? (16 - 40 1b. bond) in weight. For better
performance, use papers within the 16 - 32 1b. range.

®  When using the manual feed slot, make sure that the media is always loaded straight.

Second side of a two-sided print is upside-down

m  Select the correct method for binding preference in the printer driver.

m Long-edge binding: Page turns on the long side, regardless of image orientation.

m  Short-edge binding: Page turns on the short side, regardless of image
orientation.

m  Refer to the printer’s user guide for detailed instructions.

Letterhead paper prints on the wrong side or prints upside-down

B Manual feed: Load letterhead paper face up with the top of the page entering the
printer first.

B Tray: Load letterhead paper face down with the top of the page at the front end
of the tray.
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Problems printing on labels

Labels are printed on the wrong side

m  Make sure the labels are loaded face up in a tray, or face down in manual feed slot.

m  Make sure that two-sided printing is not selected in the printer driver; two-sided
printing is not supported for labels.

Printing labels from Microsoft Word

1. From the Tools menu, select Envelopes and Labels.
In the Envelopes and Labels dialog box, click the Labels tab.
In the labels dialog, click on the labels Option icon.

B oW N

In the Options field, select all of the following depending on label size:
Letter-size:

a. Printer: Laser and Ink-jet

b. Label Products: Avery Standard

c. Select the label size corresponding to Tektronix label media:

Avery Tektronix label media

label sizes

5160 Al/Letter (U. S.) 100 sheets / 30 labels per 016-1812-00
8.5x 11 in. sheet (each 1 x 2-5/8 in.)

5164 Al/Letter (U. S.) 100 sheets / 6 labels per 016-1813-00
8.5x 11 in. sheet (each 3-1/3 x 4 in.)

Metric-size:
a. Printer: Laser and Ink-jet
b. Label Products: Avery A4 and A5 sizes

c. Select the label size corresponding to Tektronix label media:

Avery Tektronix label media

label sizes

L7163 A4 (Metric Letter) 100 sheets / 14 labels per 016-1814-00
210 x 297 mm sheet (each 38.1 x 99.1 mm)

L7165 A4 (Metric Letter) 100 sheets / 8 labels per 016-1815-00
210 x 297 mm sheet (each 67.1 x 99.1 mm)

5. For a Macintosh: Click Print. In the Print dialog box’s General options, for Paper
Source select Manual Feed Paper.

For a PC: In the Printing Options tab, for Feed From, select Manual Feed Paper.
6. Click Print.
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Print Quality Problems

Light-colored or missing stripes on prints

m  Clean the printhead: in the front panel troubleshooting menu, select Eliminate Light
Stripes. Refer to page 123 for more information.

Ink streaks or oil on front, back, or edges of print

m  Clean the printer’s internal paper path with the front panel troubleshooting routine.
Refer to Cleaning for ink smears: paper-exit path on page 133.

m  Clean the printer’s paper-exit rollers. Refer to Cleaning for ink smears: paper-exit
path on page 133.

m  Clean the wiper blade in the Maintenance Drawer (A); refer to Cleaning for oily
streaks on page 126 for instructions.

m  Clean the printer’s Rapid Release Guide; refer to Cleaning for ink smears: paper-exit

path on page 133 for instructions.

Prints have dull, faded colors

B Ifyou are using the upper media tray, make sure that the indicator switch has been set
for the appropriate media.

B Use only Phaser 850 printer transparencies; they have been specially formulated for
this printer.

m For printing on transparencies, make sure that you have selected in the driver
Transparency (for the media tray) or Manual Feed Transparency (for the manual feed
slot).

m Try a different color correction mode or increase the print quality mode. Refer to the
printer’s user guide for more information.

Photographic images appear grainy

® In the printer driver, select the highest print quality mode.

m  Use images that are 150 dpi or higher.

Black-and-white prints instead of color

® In the printer driver, check if the TekColor Correction is set to Black and White; if it
is, choose a different color correction.

m Macintosh users:

m  Make sure that you are using the correct PPD file with the latest Apple
LaserWriter printer driver (version 8.3.4 or higher), that supports color
PostScript.

m  In the Print dialog box, make sure that Color/Grayscale is selected. Some
applications require special files to print in color. Make sure that these files are
properly installed. For information, refer to the topics on the printer’s CD-ROM
or the Tektronix World Wide Web site.

Advanced Features and Troubleshooting Manual 115



Troubleshooting Phaser 850 Printers

Black-and-white prints instead of color, cont.

m PC users:

m  Be sure to use the printer driver on the printer’s CD-ROM.

m  Make sure the application you are using is set up to print in color.

Blue colors look too purple

m  If printed blue colors look too purple, print your document with the Vivid Color color
correction. Refer to the printer’s user guide for information on color corrections.

Transparency print quality poor.

m  Use only Phaser 850 printer transparency media.

m  Make sure that you have selected Standard as the print-quality mode; try setting
Vivid Color as the color correction.

m  Make sure that the switch on the side of the Standard Paper/Transparency Tray, or on
the High-Capacity Transparency/Label Tray, is set to Transparency.

m  Make sure that you have selected in a supported printer driver either Transparency
for the media tray or Manual Feed Transparency (for the manual feed slot).

Print is wrinkled or rippled

m  If your paper is smooth, glossy, or coated, try a different type of paper. Use only
supported paper types.

B Use single-sided printing instead of double-sided printing.
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Printing problems

The printer times out when connected to a parallel port

m  Windows users: To change the timeout for transmission retry, refer to the Microsoft
Online Help for instructions.

Part of the image is missing or image is clipped

m  For more details on page sizes, print areas, and margins, refer to User Guide.
To maximize the image area, you may have to adjust the margins in your application
software.

® In your application, check the setting for Image Size.
m  Make sure you have selected the correct paper size in the printer driver.

m  Make sure you have selected Page Setup after changing printers.

You have problems printing from a specific application

B Get information and tips on printing from specific applications (such as QuarkXPress
and PageMaker) from the Tektronix Color Printer web site.

Fonts print incorrectly in Windows

m If you have downloaded fonts to your printer, or stored additional fonts on the
internal hard drive, you may need to reinstall the fonts.

m If you are using PostScript fonts, make sure ATM (Adobe Type Manager) is installed
and configured properly. ATM software is shipped with your printer.

Text prints in Courier font

m  The font you have specified is not available. The printer has 136 resident fonts.
Other fonts must be set up from the printer driver to print with each job.
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Preventing media jams

Use the following guidelines to prevent media jams inside the printer.

Make sure the printer is on a flat, level surface.
Do not overfill the media tray, as indicated by the tray’s maximum-capacity label.
Media:

m  Use only the recommended media. Refer to the printer’s user guide, or print the
Paper Tips Page from the printer’s front panel. See Internal printer pages on
page 108 for more information.

m  Make sure you use a high-quality paper: 60 - 150 g/m? (16 - 40 lb. bond) paper in
the media trays. Refer to the printer’s user guide for more information.

m  Use only Phaser 850 printer transparencies; they have been specially formulated
for this printer.

Keep paper and other supplies clean and free from dust.

Paper that has been sitting out of its sealed wrapper can become distorted,
causing paper jams. Keep paper sealed until you are ready to use it for printing.

Do not use paper that has been creased or wrinkled.
Do not print on sheets of labels that are missing labels.
Use only Phaser 850 printer labels.

Do not use perforated paper, or odd-sized paper.

For three-holed paper, make sure margins are adjusted to avoid printing over the
holes.

When using the manual feed slot:

m  Always use two hands to load the media straight and evenly.

m  Wait until a front panel message prompts you before feeding a second sheet of
paper or transparency.

Clean the printer’s rollers if they are visibly dirty. Refer to page 122 for more
information.

In high-humidity conditions, or when using speciality papers that can be printed on
both sides: Remove the paper from the paper tray, turn over the stack of paper, and
reinsert the paper into the tray.

At the printer’s front panel:

a. Scroll to Help, press Select.

b. Scroll to Jams, press Select.

¢. Scroll to Preventing Media Jams, press Select.
d

Review the Paper Tips Page.

After you clear a media jam, the printer automatically outputs a second, usually partial
print to remove any image that may remain on the print drum; then the printer prints your
original image.

The lower tray is the default tray for paper that the printer uses in self-cleaning. If you
have one or two High-Capacity Paper Tray Assemblies, you can make the upper or middle
tray the default tray through the printer’s front panel menu. Refer to Selecting the source
for cleaning pages on page 122 for instructions.
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Turning the Startup Page on or off

By default, the printer produces a Startup Page each time the printer is turned on or reset.
If desired, you can disable the Startup Page. There are three methods for turning on/
turning off the Startup Page:

From the printer’s front panel

—
.

Scroll to Menu; press Select.

2. Scroll to Printer Configuration; press Select.

3. Scroll to Default Printer Settings; press Select.

4. Scroll to Startup Page; press Select to toggle the setting.
5. Scroll to Exit; press Select.

From PhaserLink Printer Management software

Refer to the PhaserShare Networking Manual for information on using your World Wide
Web browser to access the printer via a TCP/IP network connection.

From utility files

Download one of the following files from the printer’s CD-ROM:

B Macintosh: Use the Apple Printer Utility (refer to page 95 for instructions).

m  PC: Use utility files STARTPG.PS (to turn on the Startup Page), NOSTRTPG.PS (to
turn off the Startup Page); refer to page 91 for downloading instructions.
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Protected mode for the front panel menu

System administrators can control user access to the front panel menus with PhaserLink
Software or the following utility files (refer to page 91 for instructions on downloading
utility files):

Macintosh utility files

m  Menu Short (limits menu access)

B Menu Long (expands menus)

PC utility files

B MENUSHRT.PS (limits menu access)

B MENULONG.PS (expands menus)

The “short” utility files limit the menu items displayed on the front panel, preventing
users from changing front panel settings that may affect the prints of other users. Users
instead select printing features — such as color corrections — through their applications

only. In the protected mode, users can access all menus except the Default Printer
Settings, Advanced Printer Settings, and Network Settings.

The “long” utility files reset the front panel to display full menus and allow full access to
the settings.

If you used the Menu Short or MENUSHRT.PS files to limit the front panel menus, you can
temporarily restore the full menus:

1. When the Ready to Print message appears, scroll to Menu; press Select.

2. Scroll to Printer Configuration; press Select.

3. Hold down the left arrow and press Select. The Default Printer Settings and Network
Settings selections are added to the menu and are removed again when the Printer
Configuration menu is closed.

120 Phaser 850 Color Printer



Troubleshooting Phaser 850 Printers

Turning Sys/Start Job execution on or off

You may load a startup (Sys/Start) file onto the printer’s internal hard disk, if installed.
The Sys/Start job file is similar to an init file: When you turn on the printer, the file
executes — providing that Sys/Start has been turned on either through a front panel
setting or with a control file downloaded to the printer.

If the Sys/Start file contains an error, the printer ignores the remainder of the file and may
not start up as expected.

Using the front panel

1. When the Ready to Print message is displayed, use the down arrow to scroll to Menu;
press the Select button.

Scroll to Printer Configuration; press Select.
Scroll to Default Printer Settings; press Select.
Scroll to Advanced Printer Settings; press Select.

Scroll to Sys/Start Job. Press Select to change the setting to On.

o U B =W N

To save the new setting, scroll to Exit; press Select. The Ready to Print message
appears.

7. To make the change take affect, turn the printer off and back on again.

Using utility files

Refer to page 91 for instructions on downloading utility files. To make the change take
affect, turn the printer off and back on again.

Macintosh utility files

B Set SysStart Job (Turns on automatic execution of the SysStart job.)
B No SysStart Job (Turns off automatic execution of the SysStart job.)
PC utility files

B SYSTART.PS (Turns on automatic execution of the SysStart job.)
B NOSYSTRT.PS (Turns off automatic execution of the SysStart job.)
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You need to clean the printer when prints are striped or smeared. How often you need to
clean the printer will depend on how heavily the printer is used and the environment in
which it is used.

Selecting the source for cleaning pages

The lower tray is the default source for the cleaning pages that the printer uses in its
cleaning procedures. When one or two High-Capacity Paper Tray Assemblies are
installed, you can ensure that the printer always uses paper from the lower or middle
paper tray in its self-cleaning procedures by changing a setting in the printer’s front panel:

1. When the Ready to Print message is displayed, scroll to Menu and press Select.
Scroll to Printer Configuration; press Select.

Scroll to Default Printer Settings; press Select.

Scroll to Advanced Printer Settings; press Select.

Scroll to Cleaning Page Source; press Select and choose the desired tray.

o v B WD

To return the printer to the Ready to Print message, scroll to Exit; press Select.
You can also change the default through PhaserLink Printer Management software if your

printer is connected to a network via TCP/IP. Simply enter your printer’s IP address in a
standard web browser. Refer to the PhaserShare Networking Manual or details.

Cleaning supplies

Optional cleaning kits contain presoaked alcohol wipes; order number: 016-1845-00.

If you purchase isopropyl alcohol, always use alcohol that is at least 90% pure; alcohol
that has additives can damage the printer.

Warning

Alcohol is flammable; keep alcohol-soaked wipes and swabs away from hot
surfaces.
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Light stripes on prints

If prints have narrow, lengthwise stripes that are faded or the wrong color, or prints have
missing colors, run the automatic printhead-cleaning sequence from the printer’s front

panel.
\. ! \
‘

1. When the Ready to Print message appears, scroll to Menu; press Select.

2. Scroll to Troubleshooting; press Select.
3. Scroll to Eliminate Light Stripes; press Select.

m A series of front panel messages indicate the condition of the printer as it
progresses through a sequence of automatic cleaning routines. The printer
outputs a test page at the end of the cleaning sequence you can use to confirm the
success of the procedure.
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4. Examine the test page, checking for any missing color bars. The following illustration
shows a correct Test Page with black (1), cyan (2), magenta (3), and yellow (4). Also
shown is an example of a Test Page with a missing color bar in the magenta.
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5. If one or more of the color bars are still missing or are light, repeat the cleaning
sequence.

Note

The second cleaning sequence implements a more extensive cleaning
of the printer, which may take longer for the printer to execute than
the previous cleaning.

6. Return the printer to normal operation by scrolling to Exit and pressing Select. The
Ready to Print message appears when the printer is returned to normal operation.

7. If your prints still have color stripe problems after the third cleaning sequence, turn
off the printer for at least 4 hours to allow the ink to solidify. When the printer is
turned back on, it performs a self-cleaning routine that may resolve the problem.

8. If the problems persist, perform two more Eliminate Light Stripes cleaning
procedures.

9. If your prints still have color stripe problems, service may be required.

Advanced Features and Troubleshooting Manual 125



Cleaning Phaser 850 Printers

Cleaning for oily streaks

If your prints show oily streaks, you can clean the wiper blade that is located inside the
maintenance drawer (A).

1. Open the front cover and remove the maintenance drawer (A).
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2. Use a lint-free wipe to gently wipe any excess debris from the clear plastic wiper
blade.
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3. Reinsert the maintenance drawer into the printer.
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Cleaning for ink smears: internal paper path

Clean the printer’s internal paper path surfaces if your prints have stray ink marks on the
front or the back.

9103-06

Caution

Always use clean sheets of paper to clean the paper path. Do not reuse cleaning
sheets. High-grade, heavier papers, such as 120 g/m? (32 1b.) bond, work best.

1. Load high-grade paper into the printer and make sure that the tray’s media selector
switch is set to Paper. If your printer is configured with just the upper media tray,
load that tray and set the media selection switch to Paper. If you have installed one
or two High-Capacity Paper Tray Assemblies, load either the upper tray or the lower
tray. The lower tray is the default; if you use the upper or middle paper tray, make
sure that the printer’s default has been set. Refer to Selecting the source for cleaning
pages on page 122 for details.

2. When the printer is on and the Ready to Print message appears in the front panel,
scroll to Menu; press Select.

3. Scroll to Troubleshooting; press Select.

4. Scroll to Remove Ink Smears; press Select.
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5. After a short delay during the warm-up period, the printer begins an automatic
sequence of feeding several clean sheets of paper from the media tray selected as the
cleaning page source.

6. When the cleaning sequence is complete, inspect the last sheet of paper fed through
the printer. If the printer is not clean, repeat the cleaning sequence.

7. Scroll to Exit; press Select. After a warm-up cycle, the printer returns to normal
operation.

Note

If the cleaning procedure is cancelled early, there may be a delay before the
printer is ready to perform two-sided printing.

If the ink smear problem persists:

Refer to the following two procedures for directions on cleaning paper-feed rollers and the
paper-exit path.
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Cleaning for ink smears: paper-feed rollers

The paper-feed rollers carry the print media from the media tray and manual feed slot
through the printer. Occasionally, stray ink particles become attached to the paper-feed
rollers, creating slick roller surfaces that cause media to feed improperly. If ink smear
problems persist after you have performed the “Cleaning for ink smears: internal paper
path” procedure, then clean the paper-feed rollers.

9103-07

Caution

Hot surfaces exist behind the middle paper-feed rollers. To avoid personal
injury during cleaning procedures, do not reach in behind these rollers.

1. Open the front cover.

9103-08
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3. The upper paper-feed rollers are located above the slot for the maintenance drawer
(A). To clean these rollers:

a. Use a prepackaged alcohol-soaked wipe, or use a lint-free cloth with 90-percent
isopropyl alcohol.

b. Place the cleaning wipe against each upper rubber roller, pressing to create
pressure against the roller.

¢. Use the blue thumbwheel to turn the upper rollers. The upper rubber rollers
should rotate four or five complete revolutions for each roller segment to ensure
proper cleaning. Scrub each roller thoroughly. If the wipe becomes dirty,
discard it and use another.

0643-163

4. To clean the middle rubber feed roller behind the shiny metal plate:

a. Use a prepackaged alcohol-soaked wipe, or use a lint-free cloth with 90-percent
isopropyl alcohol. Place the wipe against the underside of each middle roller.

b. Manually rotate the middle roller.
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¢. Scrub each roller thoroughly. If the wipe becomes dirty, discard it and use
another.

9103-11

5. The lower paper-feed rollers are located below the maintenance drawer (A): one set
of rollers is black rubber; the other set is white plastic. To clean the lower rollers:

a. Use a prepackaged alcohol-soaked wipe, or use a lint-free cloth with 90-percent
isopropyl alcohol. Place and hold the cleaning wipe on top of the white and
black rollers.

b. Use the blue thumbwheel to turn the rollers. Rotate the rollers four or five
complete revolutions for each roller segment to ensure proper cleaning.

¢. Scrub each roller thoroughly until clean. If the wipe becomes dirty, discard it
and use another.

0643-164
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6. To clean the shiny metal plate, use a prepackaged alcohol-soaked wipe, or use a
lint-free cloth with 90-percent isopropyl alcohol.

0643-165

7. Put the maintenance drawer (A) back into the printer.

8. Close the front cover.

132 Phaser 850 Color Printer



Cleaning Phaser 850 Printers

Cleaning for ink smears: paper-exit path

If you have already performed the other “Cleaning for ink smears” procedures described
earlier in this chapter but problems persist, you should clean the paper-exit path. Refer
also to Cleaning for ink smears: paper-feed rollers on page 129.

Occasionally, stray ink particles and oil become attached to the Rapid Release Guide,
rollers, and guides under the exit cover causing ink streaks or marks on the top edge, front,
or back of prints. When this occurs, you must clean these parts using alcohol-soaked
wipes.

Sample ink smear: paper-exit path

=

9103-13

Caution

To avoid damaging the print drum and Rapid Release Guide, never use any
sharp objects in this area, or scrape excess ink with a tool or fingernail.

1. To clean the rubber exit rollers:
a. Wrap an alcohol-soaked wipe around the index finger of one hand.

b. Press your wipe-covered finger against each roller.
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c. Use the thumbwheel to turn the rollers. Rotate the rollers four or five complete
revolutions for each roller segment to ensure proper cleaning.

‘ _
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Note

You may notice some staining of the exit rollers while performing
the cleaning procedure; this is normal and does not indicate
additional cleaning is necessary. Simply clean rollers to remove
any build-up of ink

2. Toclean the two sets of ribbed exit guides under the exit cover, gently wipe the raised
ribs using an alcohol-soaked wipe.

0643-166

0643-167
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4. Handle the Rapid Release Guide carefully to avoid bending or damaging the clear
plastic edge. Lift up on the blue tabs and remove the Rapid Release Guide. Do not
use any sharp objects in this area of the printer.

7

0643-168

5. Gently wipe the clear plastic Rapid Release Guide with a pre-soaked alcohol cloth.

0643-154

6. If the Rapid Release Guide is damaged, replace it.

7. Reinstall the Rapid Release Guide, pressing down on the blue tabs to snap the guide
into place.

8. Close the exit cover.
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Cleaning for media tray jams

If the printer incorrectly feeds paper or transparencies, or feeds more than one sheet at a
time from the media tray, refer to Preventing media jams on page 118 before cleaning the
printer. If rollers are visibly dirty, perform the following cleaning procedures.

Cleaning the media-pick roller

1. Remove the media tray from the printer.

2. Open the front cover.

9103-18

Caution

Hot surfaces exist behind the upper paper-feed rollers. To avoid
personal injury during cleaning procedures, do not reach in
behind the paper-feed rollers.

3. Remove the maintenance drawer (A) from the printer.
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4. To clean the top surface of the media-pick roller:

a. Locate the top of the media-pick roller behind the black rubber paper-path
rollers.

b. Use a prepackaged alcohol-soaked wipe, or use a lint-free cloth with 90-percent
isopropyl alcohol.

¢. Scrub the top surface of the media-pick roller thoroughly. If the wipe becomes
dirty, discard it and use another.

Replace the maintenance drawer (A) in the printer.

6. Close the front cover.
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7. To clean the bottom of the media-pick roller:

a. Use a prepackaged alcohol-soaked wipe, or use a lint-free cloth with 90-percent
isopropyl alcohol.

b. To access the pick roller, reach into the media tray slot.
Scrub the bottom surface of the pick roller thoroughly.

8. Replace the upper media tray in the printer.

Cleaning the separator pad

1. Remove the upper media tray from the printer.

2. Gently wipe the separator pad using an alcohol-soaked cloth.

]
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3. Inspect the separator pad for damage to the metal edge; it should be free of dents and
lie flat against the rubber surface. If any damage is seen, the separator pad should be
replaced (part number: 116-0838-00).

4. Replace the upper media tray in the printer.
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Cleaning for lower tray jams: paper-feed rollers

If the printer feeds paper incorrectly or feeds more than one sheet at a time from the
High-Capacity Paper Tray Assembly, refer to Preventing media jams on page 118 before
cleaning the printer. If rollers are visibly dirty, perform the following cleaning
procedures.

1. Remove the paper tray from the High-Capacity Paper Tray Assembly. If your printer
has two assemblies, remove the tray from each one. The two paper-feed rollers for
each assembly are visible when each tray is removed.

2. Using an alcohol-soaked cloth, scrub the rollers thoroughly. Rotate the roller several
times to ensure proper cleaning.

9103-22

3. Replace the paper tray in the High-Capacity Paper Tray Assembly.
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Regulatory Information for
Phaser 850 Printers

Canadian EMC (Electromagnetic Compatibility)
regulatory standards

m This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

B Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les
limits applicables aux appareils numériques de la classe B prescrites dans le
Réglement sur le brouillage radioélectrique édicté par le ministere des
Communications du Canada.
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Declaration of conformity

Tektronix, Inc.

Color Printing and Imaging Division
P.O. Box 1000

Wilsonville, Oregon 97070-1000 U.S.A.

declares, under our sole responsibility, that the products
Phaser 850 printer (Z850)

to which this declaration relates, is in conformity with the following standard(s) or other
normative document(s):

For the Safety of Information Technology Equipment including
EC EN60950:1992 Electrical Business Equipment

For the Limits and methods of measurement of radio Interference
EC EN55022:1992 characteristics of Information Technology Equipment

For the The Generic Immunity Standard

EC EN50082-1:1997 Residential, Commercial, and Light Industry.
Environmental Phenomena Basic Standard
Radio-Frequency Electromagnetic Field immunity EN 61000-4-3: 1995-02
Electrostatic Discharge EN 61000-4-2: 1995-01
Fast Burst Transient EN 61000-4-4: 1995-01
Line Surge EN 61000-4-5: 1995-02
Radio-Frequency Conducted Immunity EN 61000-4-6: 1996-03
Voltage Dips and Interruptions EN 61000-4-11: 1994-06
Flicker EN 61000-3-3: 1994-12

following the provision of the
Low Voltage Directive 73/23/EEC, the Electromagnetic Compatibility Directive
89/336/EEC, Machinery Directive 89/392/EEC.
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FCC Class B device

The equipment described in this manual generates and uses radio frequency energy. If it
is not installed and used properly in strict accordance with Tektronix’ instructions, it may
cause interference with radio and television reception.

This equipment has been tested and verified to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interferences in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one of more of the following
measures:

m  Reorient or relocate the receiving antenna.
m Increase the separation between the equipment and receiver.

m  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

m  Consult the dealer or an experienced radio/TV technician for help.
Warning

Changes or modifications not expressly approved by Tektronix can affect
emission compliance and could void the user’s authority to operate this product.
To ensure emission compliance, use shielded interface cables.
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Phaser 850 Printer
Material Safety Data Sheets

Proper management of environmental resources protects the well-being of our employees,
customers, shareholders, and the communities we are a part of worldwide.

Tektronix establishes and maintains sound environmental management practices to
accomplish this goal and to assure compliance with the laws, regulations, and orders of

the responsible governmental authorities wherever Tektronix and its subsidiaries operate.

Tektronix, Incorporated is complying with government regulations by providing Material
Safety Data Sheets for this product.

Color Printing and Imaging Division
Tektronix, Incorporated
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MSDS for Silicone Oil

SECTION 1- PRODUCT IDENTIFICATION

Trade Name: Tektronix Silicone Intermediate Transfer Layer Fluid, impregnated into printer’s
maintenance roller.

Tektronix Part Number: 016-1822-00 (replacement standard maintenance kit)

Tektronix Part Number: 016-1834-00 (replacement extended maintenance kit)

Product Use: Tektronix Phaser® 850 color printers

SECTION 2 - INFORMATION ON INGREDIENTS

Tektronix Silicone Intermediate Transfer Layer Fluid is a proprietary blend of silicone oils. Specific
identities of components, and their percentage composition, are withheld as a trade secret.

SECTION 3 - HAZARDS IDENTIFICATION

ROUTES OF EXPOSURE: Skin, eyes

POTENTIAL HEALTH EFFECTS: Health effects from this product are expected to be negligible,
when product is used as intended.

Immediate Effects:

Inhalation: Not an expected route of entry

Skin: May cause mild irritation.

Eyes: May cause mild irritation.

Ingestion: Not an expected route of exposure.

Chronic Effects: None known or expected.

SIGNS AND SYMPTOMS OF EXPOSURE

Mild skin or eye irritation.

MEDICAL CONDITIONS AGGRAVATED BY EXPOSURE
None known.

SECTION 4 - FIRST AID MEASURES

INHALATION: Not a route of exposure for this product.

EYES: Flush thoroughly with water. Seek medical attention if symptoms occur.

SKIN: Wash thoroughly with soap and water. Seek medical attention if symptoms of irritation occur.
INGESTION: Not a route of exposure for this product.

SECTION 5 - FIRE FIGHTING MEASURES

FLASH POINT: Flash point of fluid is 226 degrees C, Pensky-Martens closed-cup tester.
EXTINGUISHING MEDIA: All extinguishing agents classified as B and C are effective, including dry
powder(s), CO,, and halon.

FIRE FIGHTING INSTRUCTIONS: As for any fire, wear self-contained breathing apparatus, pressure
demand, MSHA/NIOSH approved, and protective gear.

FIRE AND EXPLOSION HAZARDS. During a fire, irritating and toxic substances may be generated
by thermal decomposition or combustion. No unusual fire hazards expected.

SECTION 6 - ACCIDENTAL RELEASE MEASURES

SPILL OR LEAK: Fluid is impregnated into maintenance roller. Small amounts (i.e., drops) may
result from normal handling. Absorb and place in an appropriate disposal container. Clean spills
thoroughly because residue can be slippery.

SECTION 7 - HANDLING AND STORAGE

HANDLING: Wash hands with soap and water after contact. Clean spills per SECTION 6.
STORAGE: No special requirements.

SECTION 8 - EXPOSURE CONTROL - PERSONAL PROTECTION
No special protection indicated when used as intended.
SECTION 9 - PHYSICAL AND CHEMICAL PROPERTIES

APPEARANCE: Clear liquid impregnated into maintenance roller.
ODOR: Mild

SOLUBILITY IN WATER: No data

SPECIFIC GRAVITY: Specific gravity of fluid is 0.97 (water=1)
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SECTION 10 - STABILITY AND REACTIVITY

STABILITY: Stable.

INCOMPATIBILITY WITH OTHER MATERIALS: Strong oxidizing agents

HAZARDOUS DECOMPOSITION PRODUCTS: At elevated temperatures, formaldehyde may be
generated.

HAZARDOUS POLYMERIZATION: Will not occur.

SECTION 11 - TOXICOLOGICAL INFORMATION
No toxicology data on mixture.

SECTION 12 - ECOLOGICAL INFORMATION
Not available.

SECTION 13 - DISPOSAL CONSIDERATIONS

Fluid is not listed as RCRA hazardous waste. Dispose of in accordance with federal, state, and local
regulations.

SECTION 14 - TRANSPORT INFORMATION
DOT: Not regulated.
SECTION 15 - REGULATORY INFORMATION

The following information pertains to the ingredients of Tektronix Silicone Intermediate Transfer
Layer Fluid:

TSCA (Toxic Substances Control Act): Listed in the TSCA inventory as verified by our suppliers.
California Proposition 65: Not regulated.

SARA (Superfund Amendment and Reauthorization Acts): Not listed in SARA Section 313. Not
listed as SARA Extremely Hazardous Substance.

RCRA (Resource Conservation and Recovery Act): Not listed as RCRA hazardous wastes.

The ingredients of this fluid are not listed as carcinogenic by OSHA, IARC or NTP.

SECTION 16 - OTHER INFORMATION

Original preparation date: September 17, 1999.

Prepared by CPID Environmental, Health, and Safety/JMP
Tektronix, Incorporated

P.O. Box 500

Chemical Documentation

Mail Stop 46-825

Beaverton, Oregon 97077

Printer information: 1-800-835-6100

MSDS information: (503) 685-2758
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MSDS for Ink Sticks

SECTION 1 - PRODUCT IDENTIFICATION

Trade Name: Tektronix Part Number:
ColorStix® Ink, Black 016-1831-00, 016-1831-50
ColorStix® Ink, Cyan 016-1825-00, 016-1828-00
ColorStix® Ink, Magenta 016-1826-00, 016-1829-00
ColorStix® Ink, Yellow 016-1827-00, 016-1830-00
Four color "rainbow" pack 016-1833-00

Product Use: Tektronix Phaser® 850 Color Printer
SECTION 2 - INFORMATION ON INGREDIENTS

Ingredients

Fatty amide waxes

Rosin ester

Phthalate ester

Black, cyan, magenta, or yellow dye

The specific identity of ingredients, and their percentage composition, are withheld as a trade secret.
Tektronix ColorStix® solid-ink sticks are considered articles under US OSHA Hazard
Communication Standard, 29CFR1910.1200. This Material Safety Data Sheet is provided as a
customer service.

SECTION 3 - HAZARDS IDENTIFICATION

ROUTES OF EXPOSURE: Skin

POTENTIAL HEALTH EFFECTS

Immediate effects: None are known or expected. See Section 11 for toxicology test information.
Long term effects: None are known or expected.

Carcinogenicity: None of the ingredients of this product are listed as carcinogens by IARC, NTP,
or OSHA.

SIGNS AND SYMPTOMS OF EXPOSURE: None expected.

MEDICAL CONDITIONS AGGRAVATED BY EXPOSURE: None expected.

SECTION 4 - FIRST AID MEASURES

EYE: Contact unlikely. If particles get into eye, flush thoroughly with water.
SKIN: Wash skin thoroughly with soap and water.

INHALATION: Not applicable

INGESTION: Not applicable

SECTION 5 - FIRE FIGHTING MEASURES

FLASH POINT: Above 200 degrees C (392 degrees F).

EXTINGUISHING MEDIA: All extinguishing agents classified as B and C are effective including dry
powder(s), CO,, and halon.

FIRE FIGHTING INSTRUCTIONS: As in any fire, wear self-contained breathing apparatus, pressure
demand, MSHA/NIOSH approved, and full protective gear.

FIRE & EXPLOSION HAZARDS: These inks will burn. During a fire, irritating and toxic gases may be
generated by thermal decomposition or combustion. No unusual fire hazards expected.

SECTION 6 - ACCIDENTAL RELEASE MEASURES
SPILL OR LEAK: Not applicable.
SECTION 7 - HANDLING AND STORAGE

HANDLING: No special precautions.
STORAGE: Avoid high temperatures. Keep ink below 70 degrees C (160 degrees F).

SECTION 8 - EXPOSURE CONTROL - PERSONAL PROTECTION

EXPOSURE GUIDELINES: None established
ENGINEERING CONTROLS/PERSONAL PROTECTION: No special protection indicated when used
as intended.

SECTION 9 - PHYSICAL AND CHEMICAL PROPERTIES

APPEARANCE/ODOR: Waxy solid. Black, blue, red, or yellow in color. Odorless.
SOLUBILITY: Not water-soluble.
SPECIFIC GRAVITY: 0.99
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SECTION 10 - STABILITY AND REACTIVITY

STABILITY: Stable.
INCOMPATIBILITY WITH OTHER MATERIALS: None.
HAZARDOUS POLYMERIZATION: Will not occur.

SECTION 11 - TOXICOLOGICAL INFORMATION

TOXICITY: Not toxic, as determined by standard laboratory tests for acute oral toxicity.

SKIN IRRITATION: Not a primary skin irritant, as determined by standard laboratory tests.
SKIN SENSITIZATION: Not a skin sensitizer, as determined by standard laboratory tests.
CARCINOGENICITY: Components or product not listed as carcinogens by IARC, NTP, or OSHA.

SECTION 12 - ECOLOGICAL INFORMATION
No known impact.
SECTION 13 - DISPOSAL CONSIDERATIONS

This product is not a hazardous waste as specified in 40CFR 261. TCLP below hazardous waste
levels set by EPA. Manage and dispose of waste in accordance with all federal, state, and local
regulations.

SECTION 14 - TRANSPORT INFORMATION
D.O.T.: Not regulated.
SECTION 15 - REGULATORY INFORMATION

TSCA: All components of these inks are listed in the Toxic Substances Control Act inventory as
verified by our suppliers.

RCRA (Resource Conservation and Recovery Act): Not a hazardous waste as specified in 40CFR261.
TCLP below hazardous waste levels set by EPA.

CALIFORNIA PROPOSITION 65: Not regulated.

SARA (Superfund Amendment and Reauthorization Act): Not regulated.

SECTION 16 - OTHER INFORMATION

Original preparation date: December 1, 1999

Prepared by CPID Environmental, Health, and Safety/JMP
Tektronix, Incorporated

P.O. Box 500

Chemical Documentation

Mail Stop 46-840

Beaverton, Oregon 97077

Printer information: 1-800-835-6100

MSDS information: (503) 685-2758
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MSDS for CleanTex® Alcopad

SECTION 1 - PRODUCT IDENTIFICATION

Trade name: Tektronix Part Number:
Alcopad 016-1845-00

Product identification numbers: 806B, 806C, 806H, 806T, 806Z, 806
Chemical name and synonyms: Isopropyl Alcohol

Chemical formula: CH,CH(OH)CH;

Emergency telephone numbers: CHEMTREC (Transportation): 1-800-424-9300
Product Use: Tektronix Phaser® 850 Color Printer

SECTION 2 - INFORMATION ON INGREDIENTS

Component CAS# % OSHA PEL (ppm) ACGIL TLV (ppm)
Isopropyl alcohol 67-63-0 91.0 400 400
Deionized water 7732-18-5 9.0 NA NA

SECTION 3 - HAZARDS IDENTIFICATION

Product is distributed as a single-use, presaturated pad, in which all the liquid is absorbed by the
applicator. Isopropyl alcohol is a flammable liquid. Eye contact will cause local irritation and
burning sensations with possible injury if not removed promptly. Repeated or prolonged contact
with skin may produce irritation and cause dermatitis. Exposure above TLV may cause irritation of
respiratory tract and eyes along with headaches, dizziness and CNS effects. May be harmful if
swallowed.

Carcinogenicity (OSHA/NTP/IARC/ACGIH): Not Listed.

Medical Conditions Aggravated by Exposure: Not Listed.

SECTION 4 - FIRST AID MEASURES

EYE CONTACT: Flush with water for 15 minutes, including under eyelids. Get Medical help.
SKIN CONTACT: Flush with water.

INHALATION: Remove to fresh air. Keep at rest. Restore and/or support breathing as needed. Get
prompt Medical attention.

INGESTION: In the unlikely event of ingestion of a wiper, first aid measures should focus on
removal of the object and preventing choking. Once removed, keep affected person at rest. Call
physician immediately.

SECTION 5 - FIRE-FIGHTING MEASURES

FLASH POINT (TCC): 56 degrees F

FLAMMABLE LIMITS (% BY VOLUME): LEL:NA UEL: NA

AUTOIGNITION TEMPERATURE degrees F (degrees C): NA

EXTINGUISHING MEDIA: Isopropyl-alcohol fires may be extinguished using carbon dioxide, dry
chemical or alcohol foam. Water may be used to cool containers exposed to the fire.
UNUSUAL FIRE OR EXPLOSION HAZARDS: Isopropyl alcohol may release vapors which may
ignite at or above flash point.

NFPA RATING: HEALTH (1)

FLAMMABILITY (3)

REACTIVITY (0)

Formulation is classified as an OSHA Class IB Flammable Liquid

NA = Not Available
SECTION 6 — ACCIDENTAL RELEASE MEASURES

Since the isopropyl-alcohol solution is completely absorbed by the applicator and the amount of
isopropyl alcohol per applicator is small, the chance of a significant spill occurring is small. In the
event however, that a significant amount of liquid is released, ventilate the area, especially low areas
where vapors may collect, and remove all sources of ignition. Cleanup personnel need protection
against liquid contact and vapor inhalation.

SECTION 7 - HANDLING AND STORAGE

Store in a clean, cool, ventilated area away from sources of ignition and oxidizing agents. Handle
and store in a manner suitable for an OSHA class IB Flammable Liquid. Electrical services must
meet applicable codes. Use non-sparking tools.

SECTION 8 - EXPOSURE CONTROL - PERSONAL PROTECTION

Provide ventilation to maintain TLV. Use non-sparking tools. Avoid inhalation of vapors, contact
with eyes and repeated or prolonged contact with skin. Do not take internally.
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SECTION 9 - PHYSICAL AND CHEMICAL PROPERTIES

BOILING POINT (80 degrees C) (180 degrees F)
% VOLATILE BY VOLUME @ 25 degrees C: 100
VAPOR PRESSURE (mmHg @ 25 degrees C): 33
EVAPORATION RATE (BUTYL ACETATE-1) >1
VAPOR DENSITY (AIR =1): <1

FORM: liquid

% SOLUBLE IN WATER @ 25 degrees C: 100
ODOR: alcohol

SPECIFIC GRAVITY (G/CC @ 25 degrees C): 0.79
APPEARANCE OF LIQUID: clear

SECTION 10 - STABILITY AND REACTIVITY

STABILITY: Stable

HAZARDOUS POLYMERIZATION: Will not occur.

INCOMPATIBILITIES / CONDITIONS TO AVOID: Caustics, amines, alkanolamines, aldehydes,
ammonia, strong oxidizing agents and chlorinated compounds.

HAZARDOUS DECOMPOSITION PRODUCTS: Carbon monoxide

SECTION 11 - TOXICOLOGICAL INFORMATION

Not Available
Section 12 — Ecological Information
Not Available.

SECTION 13 - DISPOSAL CONSIDERATIONS
Follow Federal, State and Local Regulations.
SECTION 14 - TRANSPORT INFORMATION

DOT CLASSIFICATION: Not Regulated.
Proper Shipping Name:

Hazard Class:

UN Number:

Packing Group:

Hazard Labeling:

IATA / ICAO CLASSIFICATION: Not Regulated.
Proper Shipping Name:

Hazard Class:

UN Number:

Packing Group:

Hazard Labeling:

IMDG CLASSIFICATION: Not Regulated.
Proper Shipping Name:

Hazard Class

IMDG Page #

Packing Group:

Flash Point (degrees C):

Marine Pollutant:

SECTION 15 - REGULATORY INFORMATION

SARA TITLE III REPORTING:

Toxic Chemical (Section 313): Not Listed.
Extremely Hazardous Substance: Not Listed.
Section 302, 304, 311, 312)

Hazard Class:
Chronic Health: Yes
Acute Health: Yes
Fire Hazard: Yes
Pressure Hazard: No
Reactivity Hazard: No

TSCA INVENTORY STATUS: All components listed are on the TSCA inventory.
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SECTION 16 - OTHER INFORMATION

The information provided herein is compiled from internal reports and data from professional
publications. It is furnished without warranty of any kind, expressed or implied. It is intended
solely to assist in evaluating suitability and proper use of the material and in implementing safety
precautions and procedures. Employees should use this information as a supplement to other
information gathered by them and must make independent determination of suitability and
completeness of information from all sources to assure proper use of these materials. All
information used must be determined by the user to be in accordance with applicable federal, state
and local laws and regulations.

Prepared by:

CleanTex Products
33 Murray Hill Drive
Nanuet, NY 10954

June 1997
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Specifications for Phaser 850 Printers

Temperature
Operating: 10 degrees C to 32 degrees C (50 degrees F to 90 degrees F)
Non-operating: -30 degrees C to +60 degrees C (-22 degrees F to 144 degrees F)
Humidity
Operating: 10% to 80% relative humidity, non-condensing
Non-operating: 10% to 95% relative humidity, non-condensing
Altitude
Operating: 0 to 2438 m (0 to 8000 ft.) above sea level
Shipping: 0 to 15000 m (0 to 49200 ft.) above sea level
Primary voltage ranges
90 - 140 VAG, 110 VAC nominal
180 - 264 VAC, 220 VAC nominal
Frequency range
47 to 63 Hz
Primary fusing

125 VACG, 250 VAC, 10 Amps and 6 Amps (Not user-accessible)

Power Consumption

State Typical Power Maximum Allowable
Continuous printing 220 watts per hour 600 watts per hour
Idle 180 watts per hour 300 watts per hour
Standby 130 watts per hour not applicable
Energy Star (optional) not applicable 30 watts per hour

Dimensions of the printer (without a High-Capacity Paper Tray Assembly)

Depth: 600 mm (23.5 in.)
Width: 432 mm (17 in.)
Height: 390 mm (15.3 in.)

Weight of the printer
36 kg (79 1b.)
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Dimensions of one High-Capacity Paper Tray Assembly

Height: 127 mm (5 in.)
Depth: 530 mm (20.875 in.)
Width: 440 mm (17.375 in.)

Weight of one High-Capacity Paper Tray Assembly
9.1 kg (201b.)

Sound level

Sound Pressure (Lp A); Sound Power (L, ,)
Printing: L,, <60dB (A
Lya < 7.2 Bels

)

(

Idle: LpA <45 dB (A)
Ly, < 5.6 Bels (A)

A)

Printer tilt

0389-05

Printer clearances

o — |J0cm,
: 4in.

[ ]
10cm|(4in.)

0389-06
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Index

Numerics
Ist Page Preview
resetting the timeout 100
using 100
using with PhaserPrint 88
A
accessories
ordering information 9
adding ink sticks 44
adjusting
low-resolution images 75
Adobe Photoshop plug-in 82
alcohol
purity of 122
using for cleaning 122
alcohol wipes MSDS 149
altitude, operating range 152
Apple Printer Utility
using 95
Automatic color correction 17
automatic tray switching 102
B
Black and White color correction 17
C
cart for printer, ordering information 12
CD-ROM
contents 107
cleaning
Eliminate Light Stripes 123
for High-Capacity Paper Tray Assembly jams 139
for print quality 57
ink smears from internal paper path 127
ink smears from paper-exit path 133
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Index

ink smears from paper-feed problems 129

lower pick rollers 139

oily streaks 126

overview 122

precautions using alcohol 122

print drum 133

supplies, illustrated 122

using isopropyl alcohol 122
cleaning kit

contents 122

ordering information 11
cleaning pages

changing the media tray source 122
clearing paper jams (brief) 50
CMYK Sampler, Macintosh utility file 106
collating multiple copies 76
color charts

CMYK 104

HSB 104

PANTONE Color 78

printing from a Macintosh 106

printing from the front panel 105

RGB 104
Color Connection web site 107
color corrections

Automatic 17

Black and White 17

Commercial Press 17

DIC 17

Euroscale Press 17

FujiProof 17

None 17

SNAP Press 17

sRGB Display 17
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SWOP Press 17
Toyo 17
Vivid Color 17
ColorStix ink
loading 44
ordering information 9
Commercial Press color correction 17
consumables
adding ink sticks 44
Maintenance Kit 48
D
declaration of conformity 142
DIC color correction 17
divider pages 77
downloading files from servers
Tektronix ftp server 94
World Wide Web 93
downloading files to the printer
Apple Printer Utility 95
Macintosh 95
PC 97
Windows 3.1 97
Windows 95 97
downloading fonts 72
DP Feature Set, ordering information 12
drum fluid
cleaning 133
duplex
troubleshooting 113
E
Eliminate Light Stripes
brief procedure 57
cleaning procedure 123
email notification 68, 108
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Index

enabling and disabling the Startup Page 119
energy saving mode 102
Enhanced print quality mode 16
envelopes
guidelines 27
printing details 26
printing from Microsoft Word, Macintosh 27
printing from Microsoft Word, Windows 30
printing from the manual-feed slot 22
sizes 20
Euroscale Press color correction 17
F
Fast Color print quality mode 16
Feature Set, DP, ordering information 12
Font Sampler, Macintosh utility file 74, 106
fonts
downloading 72
Macintosh 73
printing a list of resident fonts 74
sampler, printing 74
TrueType 72
FONTS.PS, PC utility file 74, 106
frequency range 152
front panel
Ist Page Preview 100
About My Printer 15
buttons 15
Eliminate Light Stripes 123
Help 15
introduction 14
light intensity 102
Menu 15
menus 120
messages, troubleshooting 109
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Printer Demo 15
FTP server
accessing 68, 108
downloading files from 94
FujiProof color correction 17
H
hard disk, ordering information 12
help pages, printer 108
High Resolution Photo
paper, ordering information 9
paper, printing on 37
print quality mode 16
High-Capacity Paper Tray Assembly
cleaning the paper-pick rollers 139
misfeeds 139
ordering information 12
paper jams 139
HSB Sampler, Macintosh utility file 106
I
IDE hard drive, ordering information 12
Image Smoothing 75
using with PhaserPrint 88
information resources 65
ink smears
cleaning internal paper path 127
cleaning paper-exit path 133
cleaning paper-feed rollers 129
ink sticks
loading 44
MSDS 147
ordering information 9
Intelligent Ready
short overview 102
internal printer pages 108
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Index

isopropyl alcohol, see alcohol
J
jams, paper
brief procedure 50
jams, trouleshooting 110
job accounting 69
job collating 76
job information 69
job separation pages 77
L
labels
guidelines 39
ordering information 10
printing on 38
printing on wrong side 114
storing 39
letterhead paper
printing on wrong side 113
light stripes
full procedure 123
light stripesbrief procedure 57
lightstripes
troubleshooting, full procedure 123
low-resolution images, adjusting for 75
M
Macintosh utility files 95
CMYK Sampler 106
Font Sampler 74, 106
HSB Sampler 106
Menu Long 120
Menu Short 120
RGB Sampler 106
maintenance
cleaning the printer 122
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maintenance drawer

wiper blade 126
Maintenance Kit

MSDS 145

ordering information 10

replacing 48
manual feed

2-sided printing 40

single-sided printing 22

supported media 21
margins

envelopes 20

paper 19
Material Safety Data Sheets (MSDS) 144
media

ordering information 9

tips 18
media jams

cleaning lower paper-pick rollers 139

exit cover 50

front cover 53

manual feed 54

output after clearing 118

preventing 118

trays 55

troubleshooting 110
media trays

lower tray jams, cleaning for 139
memory, printer, ordering information 11
Menu Long, Macintosh utility file 120
Menu Short, Macintosh utility file 120
MENULONG.PS, PC utility file 120
MENUSHRT.PS, PC utility file 120
misfeeds
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Index

High-Capacity Paper Tray Assembly 139
see also media jams
modes
print quality 16
moving the printer 63
MSDS
alcohol wipes 149
ink sticks 147
silicone oil 145
multiple copies, collating 76
N
None color correction 17
O
oil (printer drum fluid), cleaning 133
online color resource 65
online services 68, 108
p
PANTONE Colors
installing printer files 79
methods of printing 78
printer-specific colors 78
printing the color chart from a Macintosh 80
printing the color chart from a PC 81
selection books 78
paper
jams (brief) 50
margins 19
ordering information 9
print area 19
sizes 19
tips 18
paper jams
exit cover 50
front cover 53
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Index

manual feed 54
trays 55
paper jams, troubleshooting 110
paper pick roller cleaning, upper 139
paper trays
ordering information 11
PC utility files
FONTS.PS 74, 106
MENULONG.PS 120
MENUSHRT.PS 120
PhaserLink Printer Management Software
brief description 108
PhaserLink Printer Management software 69
PhaserPrint plug-in
compatibility requirements 82
for Photoshop 82
installing for Macintosh 82
installing for Windows 83
selecting options 85
starting the plug-in 84
PhaserShare Token Ring network card, ordering information 13
Photoshop plug-in 82
Plug-in, Adobe Photoshop, using 82
power consumption specifications 152
previewing a job 100
primary fusing 152
primary voltage ranges 152
print area
envelopes 20
paper 19
print drum, cleaning 133
print features
automatic tray switching 102
collating multiple copies 76
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controlling through PhaserLink 69
previewing 100
print log 69
print quality modes 16
Enhanced 16
Fast Color 16
High Resolution/Photo 16
Standard 16
print quality problems
troubleshooting 117
print separation pages 77
print speed 16
printed colors, problems with 115
printer
cart, ordering information 12
color corrections 17
dimensions 152
feature set, ordering information 12
front panel 14
front panel menus 120
internal pages 108
memory, ordering information 11
moving 63
print speed 16
quality modes 16
shipping 64
station, ordering information 12
Q
Quick Collate option 76
using with the 1st Page Preview option 76
R
Rapid Release Guide
cleaning 134
cleaning (brief procedure) 61
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ordering a replacement 11

paper jam 51
regulatory standards 141
replaceable parts

ordering information 11
RGB Sampler, Macintosh utility file 106
S
scaling images

using PhaserPrint 89
separation pages 77
server, FTP, Tektronix

downloading files from 94
setting

front panel intensity 102
shipping the printer 64
silicone oil MSDS 145
slip sheet 77
smears

ink 62

oil or ink 59
SNAP Press color correction 17
specifications 152
speed of printing 16
sRGB Display color correction 17
Standard print quality mode 16
standby mode 102
Startup Page

enable or disable 119
streaks, ink 60
stripes on prints, removing 123
supplies

ordering information 9
SWOP Press color correction 17
Sys/Start Job, enable or disable 121
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Index

T
TekColor color corrections 17
TekSMART Knowledge Base 108
Tektronix
Color Printer Information Server 94
FTP server, downloading files from 94
web site 108
Toyo color correction 17
transparencies
ordering information 10
printing from standard tray 32
printing from Transparency/Label Tray 35
printing manual feed 22
sizes 19
transparency trays
ordering information 11
tray switching 102
trays
high capacity 35
loading 32
optional assembly 33
ordering information 11
standard 31
Transparency/Label Tray 35
troubleshooting
black and white prints instead of color 115
duplex 113
Eliminate Light Stripes 123
Error ## 112
front panel messages 109
ink smears 127
labels are printed on wrong side 113
labels printing on wrong side 114
letterhead paper printing on wrong side 113

166 Phaser 850 Color Printer



light stripes, brief procedure 57
media jams 50
paper jams, preventing 118
print quality problems 117
print quality problems (brief) 57
printed colors 115
smears, ink 62
smears, oil or ink 59
streaks, ink 60
tools to help 107
two-sided printing 113
TrueType fonts 72
two-sided printing
troubleshooting 113
U
Usage Profile reports
brief overview 70
utility files
Macintosh, using 95
PC, using 97
\Y%
Vivid Color color correction 17
voltage ranges 152
W
World Wide Web
downloading files from 93
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